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Introduction

The DIVA T/A is an external ISDN modem available in S/T and U interface versions. It provides 
easy and affordable access to the Internet via ISDN. 

With the DIVA T/A, Small Office Home Office (SOHO) users and telecommuters can combine 
the higher performance of ISDN with the simplicity of a terminal adapter. The DIVA T/A 
supports all standard modem AT commands.

You can connect the DIV AT/A to a serial port on your computer that complements your 
TCP/IP application, without the need for additional device drivers. 

Internet Access

The DIVA T/A allows you to connect to the Internet over an ISDN line at speeds of up to 128 
kilobits per second. With virtually no delays, you can access online services or browse the 
World Wide Web to download high-resolution graphics, video clips, interactive games, music, 
and more.

Work-at-Home Access

The DIVA T/A provides the telecommuter with fast access to network resources back at the 
office. You can access applications such as email or download data from a remote database in 
a fraction of the time it would take using a conventional analog modem.

Analog Device Ports (certain models only)

Certain DIVA T/A models include two analog device ports (also referred to as Plain Old 
Telephone Service, or POTS). You can use these ports to connect regular telephones, 
modems or fax machines to your DIVA T/A. Calls to and from these analog devices are carried 
over your ISDN line. This saves you the expense of installing a separate analog phone line. 

The DIVA T/A supports a variety of calling features such as Call Forward, Call Waiting, 
Caller ID, Call Transfer, and Call Redirection. The available calling features, and the way each 
feature works, depends on your location. See “Analog Device Support” on page 104 for 
details.

Note:  The DIVA T/A can work independently from your computer. If the DIVA T/A is turned 
on, your analog devices can use your ISDN line regardless of whether or not the DIV AT/A is 
connected to your computer. 

Ease of Use

You can connect the DIV AT/A to any computer (desktop or notebook) equipped with a serial 
port. Under Windows 95/98/NT and Macintosh (System 7 or later), you can easily configure 
the DIVA T/A using the included DIVA Terminal Adapters software. For all platforms, the 
VT100 Configuration Tool can be used as well as AT commands.
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Installation Requirements

To install the DIVA T/A, you will require the following:

Item Description

DIVA T/A Package • DIVA T/A ISDN Modem
• DIVA T/A software (CD)
• ISDN cable (RJ-45)
• Serial cable (RS-232)
• A/C Adapter 
• Phone Adapter (RJ11) (where required)
• Terminating Resistor (if required - see page 129)
• DIVA T/A QuickStart Guide
• DIVA T/A Release Notes

Desktop or Notebook DIVA T/A can be attached to any desktop or notebook computer.

Remote Access 
Client Software

Supplied as part of operating platform or by Internet Service Provider (ISP).

ISDN Basic Rate Line Must be installed by your telephone company. 

Terminal Emulation 
Program

If you are using an operating system other than Windows 95/98/NT or 
Macintosh (System 7 or later), you will need a VT100-compatible 
terminal-emulation program (such as Telix or HyperTerminal) in order to 
configure the DIVA T/A.

Internet Access 
(Optional)

To establish an ISDN connection to the Internet, you will require the 
following:

• ISP that provides ISDN Basic Rate Interface service
• PPP and TCP/IP communications protocols for accessing your Internet 

subscription (e.g. Windows 95/98/NT Dial-Up Networking)
• TCP/IP clients (Web browser, FTP, Telnet)

Operating System • Microsoft® Windows® 95, Windows 98, or Windows NT® (3.51/4.0)
• Windows 3.x, DOS, or OS/2
• Macintosh

COM Port IBM-compatible computers:
• UART 16650 (230.4 kbps) recommended for maximum throughput
• UART 16550 

Macintosh computers
• Serial port capable of 230.4 kbps transfer recommended (found on most 

PowerMacintosh and AV Macintosh computers).



DIVA T/A ISDN Modem User’s Guide  �  Page 7

Connecting the Cables to the DIVA T/A

Follow the steps below to connect the cables to your DIV AT/A. 

1 Turn off your computer before you connect the cables.

2 Connect the RJ45 end of the ISDN cable to the jack labeled ‘ISDN’ on the rear of the 
DIVA T/A. See below to complete the connection.

• Integrated NT1 (U): Connect the other end of the ISDN cable to your ISDN wall jack.
• S/T Interface: Connect the other end of the ISDN cable to an NT1 interface, whether 

part of the ISDN service (e.g. corporate phone switch) or external. In Australia, you 
may have to change the ISDN line termination. See “ISDN Line Termination” on 
page 129 for more information.

3 If your DIVA T/A model comes with phone ports, attach the cables from analog devices 
(telephone and fax machine, for example) to the jacks labeled PHONE 1 and PHONE 2 on 
the rear of the DIVA T/A. It is recommended that you use PHONE 1 for voice and PHONE 2 
for data (modem or fax).  Phone ports are only available on certain models.

In certain countries (such as France and the United Kingdom) you must attach your 
analog devices to phone adapters before connecting them to the DIVA T/A. One adapter 
has been included in your DIVA T/A package.

4 Connect one end of the serial cable to the port labeled SERIAL on the rear of the 
DIVA T/A, and the other end to the appropriate serial port on your computer.

Note:  If you are connecting the DIVA T/A to a Macintosh, you will need a 
Macintosh-style modem cable (DB25M-to-DIN8M) that supports hardware handshaking. 
The included serial cable (DM25M-to-DB9F) is for use with IBM compatible PCs. 

5 Connect the A/C adapter connector to the power jack on the rear of the DIV AT/A, then 
plug the adapter into an AC power outlet.

Note:  On certain DIVA T/A models, the order of the serial and analog ports is reversed.

Reset

ISDN
Phone 1 Phone 2 Serial

ISDN Jack

FaxPhone

ISDN Cable

Analog
Devices

Serial
Cable

A/C
Adapter

Phone
Adapter

Desktop Computer
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Connecting the Cables to the DIVA T/A

After Connecting the Cables

After connecting the power and the ISDN cable to the DIVA T/A, wait at least 10 seconds for 
the DIVA T/A to initialize and then check the ‘D’ and ‘Link’ LEDs. If they are both glowing 
continuously, then your DIVA T/A is operational from a previous configuration. If not, you will 
have to provide information on your ISDN setup using the DIVA Terminal Adapters software, 
which you will install next. See below.

What’s Next?

The installation procedure you need to follow depends on the operating system you are 
using. Go to the page corresponding to your platform and continue.

• Windows 95/98/NT Installation and Setup...............................................9

• Macintosh (System 7 or Later) Installation and Setup..........................25

• Setup for Other Operating Systems............................................................31
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Windows 95/98/NT Installation and Setup

To properly set up the DIVA T/A with a Windows 95/98/NT system, you must connect the 
cables, configure the operating system, and install the DIVA Terminal Adapters Software. 
Once the Terminal Adapters software is installed, you will use the Configuration Wizard to set 
your ISDN parameters.

Step 1: Connect the Cables to your DIVAT/A

Following the steps outlined on page 7.

Step 2: Configure your Operating System

The configuration procedure you must follow depends on the flavour of Windows you are 
using. After you have finished connecting the cables and gathering the required information, 
go to the page that corresponds to your platform.

• Windows 95 (Original Release and SP1) ....................................................10

• Windows 95 (OSR2) ...........................................................................................12

• Windows 98 .........................................................................................................14

• Windows NT 4.0..................................................................................................16

• Windows NT 3.51 ...............................................................................................19

Note:  If you are using Windows 3.x, see page 31.

Step 3:  Install the DIVA Software

The Setup Wizard installs all necessary files on your system. These include the DIVA T/A 
on-line documentation, the DIVA Terminal Adapters Program, and the Uninstall utility.

Following the steps outlined on page 20.
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Windows 95/98/NT Installation and Setup

Windows 95 (Original Release and SP1)

This install procedure is for the original release and Service Pack 1 (SP1) version of 
Windows 95. If you are using Windows 95 Service Release 2 (OSR2), go to “Windows 95 
(OSR2)” on page 12. 

To verify the version installed on your machine, click ‘Start’, ‘Settings’, ‘Control Panel’, ‘System’, 
then click the ‘General’ tab. If you have the original or SP1 version of Windows 95 installed, 
you will see ‘4.00.950’ or ‘4.00.950 A’, as shown.

   

DUN 1.2 or Later Required

If you are using Dial-Up Networking (DUN), make sure you are using version 1.2 or later. If you 
are running a previous version, you must upgrade to DUN 1.2 or later before installing the 
DIVA T/A.  For your convenience, DUN 1.3 is included on the DIVA T/A CD-ROM; run SETUP.EXE 
from the CD-ROM and click ‘Bonus Software’.

Setup Instructions

Follow these steps to set up the DIVA T/A under Windows 95 (Original Release and SP1).

1 Power on your PC with all cables connected (see page 7 for instructions).

2 Windows 95 detects the DIVA T/A and the ‘New Hardware Found’ window appears.

3 Insert the DIV AT/A CD into your computer's CD drive.

4 In the ‘New Hardware Found’ window, select ‘Driver from disk provided by hardware 
manufacturer’ and click ‘OK’. The ‘Install From Disk’ window appears.
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Windows 95/98/NT Installation and Setup

5 In the ‘Install From Disk’ window, enter the drive letter of your CD drive (or use the 
Browse button to locate your CD drive) and click ‘OK’.

6 In the ‘Select Device’ window, select ‘Eicon DIVA T/A ISDN Modem’ and click ‘OK’. 

7 Go to “Installing the DIVA Software” on page 20.
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Windows 95/98/NT Installation and Setup

Windows 95 (OSR2)

This install procedure is for Windows 95 Service Release 2 (OSR2). If you are using original 
release or Service Pack 1 (SP1) version of Windows 95, go to “Windows 95 (Original Release 
and SP1)” on page 10. 

To verify the version installed on your machine, click ‘Start’, ‘Settings’, ‘Control Panel’, ‘System’, 
then click the ‘General’ tab. If you have Windows 95 OSR2 installed, you should see 
‘4.00.950 B’, as shown.

DUN 1.2 or Later Required

If you are using Dial-Up Networking (DUN), make sure you are using version 1.2 or later. If you 
are running a previous version, you must upgrade to DUN 1.2 or later before installing the 
DIVA T/A.  For your convenience, DUN 1.3 is included on the DIVA T/A CD-ROM; run SETUP.EXE 
from the CD-ROM and click ‘Bonus Software’.

Setup Instructions

Follow these steps to set up the DIVA T/A under Windows 95 (OSR2).

1 Power on your PC with all cables connected (see page 7 for instructions).

2 Windows 95  detects the DIV AT/A and the ‘New Hardware Found’ window appears 
followed by the ‘Update Device Driver Wizard’ window.

3 Insert the DIV AT/A CD into your computer's CD drive.

4 From the ‘Update Device Driver Wizard’ window, click ‘Next’.

5 Click ‘Other Location’.
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Windows 95/98/NT Installation and Setup

6 Enter the drive letter of your CD drive (or use the Browse button to locate your CD drive) 
and click ‘OK’. 

7 In the ‘Update Device Driver Wizard’ window, click ‘Finish’.

8 Go to “Installing the DIVA Software” on page 20.
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Windows 95/98/NT Installation and Setup

Windows 98

Warning!

It is very important to follow the steps, exactly as described below, to install the DIVA T/A 
software. The setup file for ISDN modems (mdmisdn.inf), supplied on the Microsoft Windows 
98 CD, contains incorrect information about the DIV AT/A ISDN Modem (incorrectly referred 
to as ‘Eicon T-A External’). Using this setup file will cause the DIV AT/A to operate incorrectly. 
DO NOT use the ‘Add New Hardware’ applet (found in ‘Control Panel’) to install the DIVA T/A.

Setup Instructions

Follow these steps to set up the DIVA T/A under Windows 98.

1 Power on your PC with all cables connected (see page 7 for instructions).

2 Windows 98  detects the DIV AT/A and the ‘New Hardware Found’ window appears, 
followed by the ‘Add New Hardware Wizard’ window.

3 Insert the DIV AT/A CD into your computer's CD drive.

4 From the ‘Add New Hardware Wizard’ window, click ‘Next’.

5 Select the ‘Search for the best driver for your device’ option and click ‘Next’.
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Windows 95/98/NT Installation and Setup

6 Select ‘CD-ROM drive’ and click ‘Next’.

7 Click ‘Next’.

8 Click ‘Finish’ and go to “Installing the DIVA Software” on page 20.
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Windows 95/98/NT Installation and Setup

Windows NT 4.0

RAS Recommended

Before you begin installing the DIVA T/A, we suggest that the Remote Access Service (RAS), 
also known as Dial-Up Networking, be installed with at least one modem. Any modem will 
do; it is only needed to install the DIVA T/A and can later be removed.

Setup Instructions

Follow these steps to set up the DIVA T/A under Windows NT 4.0.

1 Power on your PC with all cables connected (see page 7 for instructions).

2 Insert the DIV AT/A CD into your computer's CD drive.

3 Click ‘Start’, ‘Settings’, ‘Control Panel’, then double-click the ‘Modems’ icon. If you have 
previously installed a modem, the ‘Modem Properties’ window opens; click ‘Add’. If you 
have not previously installed a modem, go to step 4.
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Windows 95/98/NT Installation and Setup

4 The ‘Install New Modem’ window appears. Select ‘Don't detect my modem; I will select it 
from a list’ then click ‘Next’.

Important:  Make sure that you select the choice above and do not let Windows NT 
choose its own modem driver. If you let Windows NT select the modem driver, you will 
not be able to communicate with the DIVA T/A. You will then have to delete the Win-
dows NT installed modem and begin the install process again from Step 3.

5 From the ‘Install New Modem’ window, click ‘Have Disk’. When prompted, enter the path 
to the CD (or use the Browse button to locate your CD drive), then click ‘OK’. The DIVA T/A 
will be detected.
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Windows 95/98/NT Installation and Setup

6 Select ‘Eicon DIVA T-A ISDN Modem’, then click ‘Next’.

7 Select the appropriate COM Port the DI VAT/A is connected to. Click ‘Next’, then click 
‘Finish’.

8 Close the ‘Modem Properties’ window.

9 After closing the ‘Modem Properties’ window, you are prompted to configure Dial-Up 
Networking, as the install modem list has changed. Click ‘Yes’ to configure Dial-Up 
Networking.

10 From the ‘Remote Access Setup’ window, remove any unused devices that use the same 
COM port as the DIVA T/A, and then click ‘Add’.

11 In the ‘Add RAS Device’ window, select the Eicon DIVA T/A ISDN Modem from the 
drop-down list and click ‘OK’.

12 From the ‘Remote Access Setup’ window, click ‘Continue’. You will be prompted to shut 
down and restart your computer. Click ‘No’. Do not restart your system.

13 Go to “Installing the DIVA Software” on page 20.
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Windows 95/98/NT Installation and Setup

Windows NT 3.51

Note on RAS

If you are going to use the DIVA T/A with RAS, RAS must already be installed with at least one 
modem. Any modem will do; it is only needed to install the DIVA T/A and will later be 
removed. If you do not want to use RAS, go to “Installing the DIVA Software” on page 20.

Setup Instructions

1 Power on your PC with all cables connected (see page 7 for instructions).

2 Insert the DIV AT/A CD into your computer's CD drive.

3 Open any text editor.

4 Using your text editor, open the file MODEM.INF found in the Windows\System32\RAS 
directory.

5 Open the file WFWNTEI2.INF (found at the root of the DIV AT/A CD).

6 Copy the contents of WFWNTEI2.INF and append it to the end of the MODEM.INF file; 
save the appended MODEM.INF file, and exit your text editor.

7 You must now start the RAS setup program. From ‘Control Panel’, double-click the 
‘Network’ icon. From the ‘Installed Network Software’ list, select ‘Remote Access Service’ 
and click ‘Configure’.

8 From the RAS setup, remove the unused modem or any other devices that use the same 
COM port as the DIVA T/A, add the DIVA T/A, and then exit RAS. Refer to the RAS online 
help for removing and adding modems.

9 After exiting the RAS setup, you are prompted to reboot your PC. Click ‘OK’ and allow 
your PC to reboot and Windows NT to restart. To shut down the RAS server, double-click 
the ‘Remote Access Admin’ icon in the ‘Remote Access Service’ program group. From the 
‘Remote Access Admin Server’ menu select ‘Stop Remote Access Server’, and then exit 
the Remote Access Admin program.

10 Go to “Installing the DIVA Software” on page 20.
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Windows 95/98/NT Installation and Setup

Installing the DIVA Software

The Setup Wizard installs all necessary files on your system. These include the DIVA T/A 
on-line documentation, the DIVA Terminal Adapters Program, and the Uninstall utility.

Before you proceed, make sure you have completed the pre-installation procedure relevant 
to your software platform. To find the procedure relevant to your platform, see “Step 2: 
Configure your Operating System” on page 9.

Installation Instructions

1 Insert the DIV AT/A CD.

2 Click ‘Start’ then ‘Run’ from the Windows Taskbar.

3 Enter d:\SETUP.EXE in the ‘Run’ field, with d: being the drive letter of your 
CD-ROM drive). Click ‘OK’.

4 The DIVA T/A ‘Welcome’ screen appears. Click the ‘Software / Documentation’ button.

Note:  You can change the language by clicking on the ‘Select language’ button at the 
bottom left of the screen.
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Windows 95/98/NT Installation and Setup

5 Click the ‘Install DIVA T/A ISDN Modem Software’ button.

6 The Setup Wizard starts. Click ‘Next’ in the Setup Wizard's ‘Welcome’ screen.
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Windows 95/98/NT Installation and Setup

7 Specify where you want to install the DIV AT/A software. Click ‘Next’ to install in the 
default directory (this differs according to your platform); otherwise, click the ‘Browse’ 
button and select a directory, then click ‘Next’. 

The Setup Wizard installs all necessary files. 

8 Once complete, the ‘Congratulations’ screen appear. Verify that the ‘Launch 
Configuration Tool’ option is checked and click ‘Finish’.

Note:  If you want to configure the DIVA T/A later, uncheck ‘Launch Configuration Tool’ 
before clicking ‘Finish’. The Configuration Tool can be accessed later through the Eicon 
DIVA Terminal Adapters program. You can launch this program by double-clicking the 
‘T/A’ icon on the taskbar, or by clicking ‘Start’, ‘Programs’, ‘Eicon DIVA T-A ISDN Modem’, 
‘Eicon DIVA Terminal Adapters’.

9 The DIVA Terminal Adapters Program for Windows 95/98/NT launches and detects your 
DIVA T/A ISDN Modem.
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Windows 95/98/NT Installation and Setup

10 The Configuration Wizard’s ‘Welcome’ screen appears. Click ‘Next’ and follow the 
on-screen instructions. 

Note:  If an existing configuration is detected, you can skip the Wizard. To keep the 
existing configuration, click ‘Next’. To reconfigure your device using the Wizard, select 
‘Reconfigure using the Configuration Wizard’, then click ‘Next’.

You should not click the ‘Configure’ button unless you know all of your ISDN parameters 
and want to configure them manually. If you click ‘Configure’, the Wizard closes and the 
Windows 95/98/NT Configuration Tool starts. If you select this option go to “Configuring 
a Profile using the Configuration Tool” on page 37.

Context sensitive help is available on all the Configuration Wizard's screens. For more 
details about a particular field displayed on the screen, click the Question Mark ‘?’ icon at 
the top right corner of the screen, then click on a field.
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Windows 95/98/NT Installation and Setup

11 When the ‘Congratulations’ screen appears, the installation is complete. Click ‘Finish’. 

The Wizard closes and the Eicon DIVA Terminal Adapters program appears. (For more 
information on using this software, see page 32.) 

Installation Complete

The installation under Windows 95/98/NT is complete. If the ‘D’ LED on your DIVA T/A is 
glowing continuously, the modem is ready to use. 

• If you want to configure additional profiles or configure advanced ISDN parameters for 
the profile you created above, go to “The DIVA Terminal Adapters Program for 
Windows 95/98/NT” on page 32.

• If you want to learn more about using your DIVA T/A, go to “Using the DIVA T/A” on 
page 84.
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Macintosh (System 7 or Later) Installation 
and Setup

To properly set up the DIVA T/A with a Macintosh system (System 7 or later), you must 
connect the cables, then install the DIVA Terminal Adapters software. You can then use the 
Configuration Assistant to set your ISDN parameters.

Step 1: Connect the Cables to your DIVAT/A

Following the steps outlined on page 7.

Step 2: Install the DIVA Terminal Adapters Software

The installation program copies all necessary files on your system. These include the DIVA T/A 
on-line documentation and the DIVA Terminal Adapters Program.

Follow the steps outlined on page 26.

Step 3: Specify your ISDN Settings via the Configuration Assistant

The Configuration Assistant helps you configure your DIVA T/A ISDN Modem to work with 
your ISDN network connection. Later you may re-run the Assistant or make changes 
manually using the Configuration Tool.

Follow the steps outlined on page 28.
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Macintosh (System 7 or Later) Installation and Setup

Installing the DIVA Software

The installation program copies all necessary files on your system. These include the DIVA T/A 
on-line documentation and the DIVA Terminal Adapters Program.

1 Power on your PC with all cables connected (see page 7 for instructions).

2 Insert the DIV AT/A CD into your CD ROM drive.

3 Double-click the CD icon.

4 Double-click the ‘Eicon DIVA T/A Installer’ icon.

5 When the Eicon DIVA T/A ISDN Modem splash screen appears, click ‘Continue’.

6 Click ‘Install’.

7 When prompted, select a destination for the configuration tool files. The free space 
available in the selected location is shown in this dialog box. Once your select a 
destination, click ‘Install’ in the dialog and follow the prompts to finish the installation.

Note:  You may be asked to select a destination for modem scripts. Usually these are 
placed in the ‘Modem Scripts’ folder in the ‘Extensions’ folder of ‘System Folder’.
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Macintosh (System 7 or Later) Installation and Setup

8 Click ‘OK’ at the ‘Installation was successful’ message.

9 Continue with “Specifying ISDN Settings via the Configuration Assistant” on page 28.
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Macintosh (System 7 or Later) Installation and Setup

Specifying ISDN Settings via the Configuration Assistant

The Configuration Assistant helps you configure your DIVA T/A ISDN Modem to work with 
your ISDN network connection. Later you may re-run the Assistant or make changes 
manually using the Configuration Tool.

1 Open the ‘Eicon Technology’ folder, then the ‘DIVA Terminal Adapters’ folder.

2 Double-click the ‘Eicon DIVA Terminal Adapters’ icon.

3 Upon startup, the DIVA Terminal Adapters program searches for devices connected to 
your system. If your DIVA T/A is detected, the ‘New Device’ window appears.

 

4 Click ‘OK’. This will start the Configuration Assistant. 

If you do not want to be notified of a new device at startup, enable the ‘Don’t suggest 
configuration of new device at startup’ checkbox before clicking ‘OK’.

If you do not want to configure the DIV AT/A at this time, click ‘Cancel’.
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Macintosh (System 7 or Later) Installation and Setup

5 At the ‘Welcome’ screen, click ‘Next’ and follow the Configuration Assistant’s on-screen 
instructions. 

Note:  You should not click the ‘Configure’ button unless you know all of your ISDN 
parameters and want to configure them manually. If you click ‘Configure’, the Assistant 
closes and the Configuration Tool starts. If you select this option, see “Configuring a 
Profile using the Configuration Tool” on page 60.

6 When the ‘Congratulations’ screen appears, the installation is complete. Click ‘Finish’.
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7 The Assistant closes and the Eicon DIVA Terminal Adapters program appears. Setup is 
now complete; you may quit the program by selecting ‘Quit’ from the ‘File’ menu.

 

Installation Complete

The installation is complete. If the ‘D’ LED on your DIVA T/A is glowing continuously, the 
modem is ready to use. 

• If you want to configure additional profiles or configure advanced ISDN parameters for 
the profile you created above, you can use the DIVA Terminal Adapters program (see 
page 55).

• If you want to learn more about using your DIVA T/A, see page 84.
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The DIVA T/A does not include native installation applications for Windows 3.x, Windows for 
Workgroups 3.11, DOS, OS/2, Macintosh (prior to System 7), and other operating systems. 
However, it is still possible to configure the DIV AT/A using the VT100 Configuration Tool. A 
VT100-compatible terminal emulation program is required.

Windows 3.x and Windows for Workgroups 3.11

If you are going to use the DIVA T/A with RAS for WFW, RAS must already be installed with at 
least one modem. Any modem will do; it is only needed to properly install the DIVA T/A and 
will later be removed. 

If you are using RAS, follow the steps below. If you do not want to use RAS, see “The VT100 
Configuration Tool” on page 73.

1 Connect the cables to your DIVA T/A as outlined on page 7.

2 Power on your PC.

3 Insert the DIV AT/A CD into your computer's CD drive.

4 With any text editor, open the file MODEM.INF found in the Windows\System directory.

5 Open the file WFWNTEI2.INF (found at the root of the DIV AT/A CD).

6 Copy the contents of WFWNTEI2.INF to the end of the MODEM.INF file; save the 
appended MODEM.INF file, and exit your text editor.

7 Start the RAS setup program.

8 From the RAS setup, change the unused modem to the DIVA T/A. Refer to the RAS online 
help to change modems.

9 To set your ISDN parameters, follow the instructions provided in “The VT100 
Configuration Tool” on page 73.

DOS, OS/2, Macintosh (prior to System 7), and Others

1 Connect the cables to your DIVA T/A as outlined on page 7.

2 Power on your PC.

3 To set your ISDN parameters, follow the instructions provided in “The VT100 
Configuration Tool” on page 73.
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The DIVA Terminal Adapters Program for 
Windows 95/98/NT

The DIVA Terminal Adapters Program and Configuration Tool for Windows 95/98/NT provides 
a variety of convenient utilities for editing your ISDN settings.

In this Chapter:

Introduction........................................................................................... 33

The Profiles Window ........................................................................... 35

About Configuration Profiles........................................................... 36

Configuring a Profile using the Configuration Tool................. 37
General Tab....................................................................................... 38
Phone Port Tabs .............................................................................. 41
Data Tab............................................................................................. 44
BACP Tab............................................................................................ 46
X.25 Tab.............................................................................................. 48
Advanced Tab .................................................................................. 51
Voice to PC Tab ................................................................................ 53

Configuring a Profile using the Wizard ........................................ 54



DIVA T/A ISDN Modem User’s Guide  �  Page 33

The DIVA Terminal Adapters Program for Windows 95/98/NT

Introduction

Launching the DIVA Terminal Adapters Program

To launch the Terminal Adapters program:

• double-click the T/A icon on the taskbar, or

• click ‘Start’, ‘Programs’, ‘Eicon DIV AT-A ISDN Modem’, ‘Eico nDIVA Terminal Adapters’.

The ‘Eicon DIVA Terminal Adapters Program’ window appears as shown below.

You can launch the Configuration Tool by double-clicking on the DIVA T/A icon. The 
Configuration Tool allows you to edit your ISDN settings. For more information, see 
“Configuring a Profile using the Configuration Tool” on page 37.

Getting Help

To access the extensive on-line help, select ‘Help Topics’ from the ‘Help’ menu. 

Menu Options

The menu bar provides you with a variety of shortcuts and utilities. You can launch 
commands from drop-down menus or by clicking icons. 

Displaying Icons in the Toolbar

To display icons, select ‘Toolbar’ from the ‘View’ menu. The Toolbar pick list displays four 
options: ‘Basic’, ‘Advanced’, ‘View’, and ‘Tools’. Select an option to have its associated icons 
displayed on the toolbar (a checkmark next to an option indicates it is already visible). Select 
‘Enable’ to hide or show the whole toolbar.
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The following table describes the action that each icon performs. To make sure you can see 
all the icons, select ‘Toolbar’ from the ‘View’ menu, then enable all the options in the list.

Click or Select To perform this Action

File >
Configure

Opens the Configuration Tool for the active profile, allowing you modify 
your ISDN settings. See “Configuring a Profile using the Configuration Tool” 
on page 37 for more information.

File >
Wizard

Launches the Configuration Wizard, which takes you step-by-step through 
the configuration of your ISDN settings. Changes are saved to the active 
profile. Not all settings can be configured through the Configuration 
Wizard. If you wish to modify all parameters, configure the profile manually 
using the Configuration Tool (see next command).

File >
Configure 
Profiles

Opens the Profiles window. The Profiles window allows you to edit and 
rename any of the three profiles. This is also where you set the active profile.

File >
Download 
Firmware

Downloads new Firmware. See “Updating Firmware” on page 79 for more 
details.

File >
Factory Reset

Resets your DIVA T/A to the original factory settings. 

File >
Details

Displays a panel that contains details about your DIVA T/A. Use it if you need 
to determine details about your configuration (such as your firmware 
version).

File >
Delete

Deletes the currently selected device.

File >
Import Profiles

Imports a profile file (.PRF), which contains three profiles plus other 
configuration parameters. The file is imported to the selected device.

Files >
Export Profiles

Exports the device configuration, which includes three profiles, to a profiles 
file (.PRF). Before updating firmware, it is strongly recommended that you 
export your current profiles.

View >
Refresh

Refreshes information about the selected device.

Tools >
Connect

Opens the ‘Make New Connection’ dialog box. Configured Dial-Up 
Networking connections are available from the drop down list. If you are 
using Windows NT, you can use this option to run RAS.

Tools >
Modems

Opens the ‘Windows Modem Properties’ box. 

Tools >
Terminal

Launches a terminal emulation program, from which you can use AT 
commands on your device. This is primarily used for troubleshooting.
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The Profiles Window

The Profiles window allows you to edit any of the three profiles using the Configuration Tool 
or Configuration Wizard. You can also rename profiles or set the active profile. 

To open the Profiles window:

1 Double-click the T/A icon on the taskbar to start the Terminal Adapters program, or click 
‘Start’, ‘Programs’, ‘Eicon DIVA T-A ISDN Modem’, ‘Eicon DIVA Terminal Adapters’.

2 Right-click on the device icon and choose ‘Configure Profiles’. You can also select the 
device icon and choose ‘Configure Profiles’ from the ‘File’ menu.

The ‘Profiles’ window opens.

If you want to... Then do this

Configure a profile 
manually

Select a profile from the ‘Profiles’ list in the center of the window, then 
click the ‘Configure’ button (see page 37).

Configure a profile 
using the Wizard

Select a profile from the ‘Profiles’ list in the center of the window, then 
click the ‘Wizard’ button (see page 54).

Rename a profile Select a profile from the ‘Profiles’ list in the center of the window, then 
click the ‘Rename’ button.

Set the active profile Select a profile from the ‘Active Profile’ list at the bottom of the window, 
then click ‘OK’. 

The active profile is the profile the DIVA T/A uses when powering up. The 
Configuration Tool also opens the active profile when you double-click 
on the device icon, as does the Wizard when you run it from the File 
menu.
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About Configuration Profiles

A profile is a set of parameters that define a particular ISDN setup. 

When you installed the DIVA software, the Configuration Wizard helped you configure your 
ISDN settings. This set of settings was given the default name Profi l e0. 

In addition to this profile, you can configure two other profiles that define different ISDN 
setups, which can correspond to the needs of your different applications. For example, you 
may configure profiles to match the ISDN setup needed to connect to your office, your 
Internet Service Provider (ISP), and CompuServe. When you need a particular ISDN 
configuration, you simply select the appropriate profile. This saves you the trouble of 
reconfiguring all your ISDN parameters each time you switch applications. 

Parameter Categories

The different settings are described briefly below. The categories correspond with the panels 
in the Configuration Tool.

Configuring Profiles

• To configure a profile manually using the Configuration Tool, see page 37.

• To configure a profile using the Configuration Wizard, see page 54.

General General ISDN settings include your location and data protocol (which must match the 
protocol implemented at the other end of the connection). If your DIV AT/A is not 
equipped with phone ports, you must also specify your ISDN phone numbers in this 
panel. For more details, see page 38.

Phone Ports If your DIVA T/A is equipped with analog device ports, the Phone Port 1 and Phone 
Port 2 tabs allow you to specify several options, such as which phone numbers the 
analog ports should answer. For more details, see see page 41. For more information on 
analog device support, see page 104. 

Data The Data tab allows you to configure data port and protocol options. For more details, 
see page 44.

BACP The BACP tab allows you to specify the Bandwidth Allocation Control Protocol and ISDN 
cost reduction parameters. This tab is visible only if the data protocol is set to ‘MultiLink 
PPP with BACP’ or ‘MultiLink PPP with AODI’, and is discussed in more detail on page 46.

X.25 The X.25 settings only apply if AO/DI is supported by your ISDN service provider, and is 
visible only if the data protocol is set to ‘MultiLink PPP with AODI’. Use this panel to 
specify the X.25 version and X.25 facilities as required. For more details, see page 48.

Advanced The Advanced tab allows you to specify advanced ISDN parameters such as Call 
Routing, and is optional. For more details, see page 51.

Voice to PC This tab is visible only if the ‘Voice to PC’ option is enabled in the ‘Advanced’ tab. For 
more details, see page 53.



DIVA T/A ISDN Modem User’s Guide  �  Page 37

The DIVA Terminal Adapters Program for Windows 95/98/NT

Configuring a Profile using the Configuration Tool

To configure a profile manually using the Configuration Tool:

1 Double-click the T/A icon on the taskbar to start the Terminal Adapters program, or click 
‘Start’, ‘Programs’, ‘Eicon DIVA T-A ISDN Modem’, ‘Eicon DIVA Terminal Adapters’.

2 To configure the active profile, double-click the ‘DIVA T/A’ icon. The Configuration Tool 
appears. By default, the General tab is displayed.

Note:  To make changes to one of the other profiles, you must first use the ‘Profiles’ 
window. See “The Profiles Window” on page 35 for more information.

3 Go through each panel and make your changes. To move from panel to panel, click on 
the tabs at the top of the window. Note that some tabs do not appear unless certain 
options are configured. For example, the ‘BACP’ tab is not visible unless ‘MultiLink with 
BACP’ is chosen as the protocol in the ‘General’ tab.

For descriptions on parameters, refer to the sections below.

General Tab....................................................................................... 38
Phone Port Tabs .............................................................................. 41
Data Tab............................................................................................. 44
BACP Tab............................................................................................ 46
X.25 Tab.............................................................................................. 48
Advanced Tab .................................................................................. 51
Voice to PC Tab ................................................................................ 53

This information is also available through context-sensitive help. Click the question mark 
‘?’ icon at the top right corner of the screen, then click on a field or button.

4 Click ‘OK’. The changes are written back to the device.

5 After the DIVA T/A has restarted, check the ‘D’ and ‘Link’ LED on the front panel of the 
DIVA T/A. If the LEDs are steady, the DIVA T/A is working correctly; if they are not steady, 
check your configuration and try again. Note that, in Europe, an inactive ‘Link’ LED 
indicates an idle condition. (For more details on the LEDs, see “LED Status Indicators on 
the DIVA T/A” on page 132.)

For information on using your DIVA T/A modem, see “Using the DIVA T/A” on page 84.
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General Tab

The General tab allows you to configure your location as well as the protocol you wish to use.

If your DIVA T/A does not have phone ports, this is also where you specify your ISDN directory 
numbers. For DIVA T/A models with phone ports, this tab allows you to enable or disable 
individual ports; directory numbers are specified in the Phone Port tabs (see page 41).

Of the screen captures shown below, the first one is the ‘General’ tab for devices with phone 
ports; the second one is for devices that do not have phone ports.

  

Country

This setting ensures that the correct options specific to your country are used. If your country 
is not listed, select ‘Other’ and default options will be used.

Data

The data protocol must match the remote ISDN device to which you are going to connect. 
Your options are ‘PPP’, ‘MultiLink PPP’, ‘MultiLink PPP with BACP’, ‘MultiLink PPP with AODI’, 
‘V.110’, and ‘V.120’.

Setting Description

PPP ‘PPP’ operates on a single ISDN channel. Since two ISDN channels are available, the 
DIVA T/A can support two PPP connections at the same time. This is useful if you 
need to have two connections running concurrently. For example, you could use one 
channel to maintain a connection to the Internet, and another to connect to a 
remote corporate network. Or perhaps you wish to support incoming data calls, as a 
PPP connection will never be disconnected to allow an incoming or outgoing analog 
call. Note that if two PPP connections are active, no analog calls can be made.
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MultiLink PPP When you activate Multilink PPP, the DIVA T/A combines both ISDN B-channels into a 
single 128 kbps communications link. Both channels remain in use as long as long as 
the connection is active, which may result in excessive ISDN connection charges if 
the link is frequently idle. 

Multilink PPP reserves both ISDN B-channels for its exclusive use. If you use Multilink 
PPP, you will not be able to make or receive other data calls.

Analog calls are governed by a different set of rules. By default, the DIVA T/A is 
configured to support call bumping, which causes the DIVA T/A to drop one ISDN 
channel when you make or receive an analog call. 

This reduces the throughput of the data call to 64 kbps. When the analog call is 
done, Multilink PPP re-establishes the second channel, returning the data 
connection to 128 kbps. 

Only one of the two PHONE ports can be used when a Multilink PPP connection is 
active.

MultiLink PPP 
with BACP

To save on communications charges, use Bandwidth Allocation Control Protocol 
(BACP) in combination with Multilink PPP. The DIVA T/A uses BACP to monitor 
incoming and outgoing traffic. 

As traffic volume warrants, a second ISDN channel is opened or closed. This reduces 
your communications charges by ensuring that two ISDN channels are never active 
when one is sufficient. 

As with MultiLink PPP, this setting reserves both ISDN B-channels for its exclusive use. 
This means that if your Internet connection uses ‘MultiLink PPP with BACP’, you will 
not be able to make or receive other data calls. 

As with MultiLink PPP, if both B-channels are active, call bumping forces the DIVA T/A 
to drop one ISDN channel when you make or receive an analog call.

Only one phone port can be used when a ‘MultiLink PPP with BACP’ connection is 
active. However, since ‘MultiLink PPP with BACP’ may only be using one ISDN 
channel, either Phone 1 or Phone 2 may not be available. 

For example, if Phone 2 was in use when the data connection was established, the 
data connection uses telephone number 1. Even though telephone number 2 
becomes available when Phone 2 hangs up, the data connection does not switch 
over. If you try to use Phone 1, you will get a busy signal.

MultiLink PPP 
with AO/DI

Always On/Dynamic ISDN (AO/DI) uses the ISDN D-channel to maintain a permanent 
connection to your ISP or corporate network. The D-channel connection operates at 
16 kbps using the X.25 protocol. However, only 8-9 kbps is available for data transfer, 
but it can be used to send and receive low-bandwidth data such as email.

AO/DI incorporates BACP, and uses it to monitor incoming and outgoing traffic. 
When traffic volume warrants, it enables one or two ISDN B-channels to meet 
demand. As with MultiLink PPP, this setting reserves both ISDN B-channels for its 
exclusive use. If your Internet connection uses ‘MultiLink PPP with AO/DI’, you will 
not be able to make or receive other data calls.

When using ‘MultiLink PPP with AO/DI’, both B-channels can be dropped, allowing 
you to make or receive two analog calls. Since the data connection is still active on 
the D-channel, you can use both phone ports at any time. However the speed of the 
D-channel (16 kbps) is much slower than a B-channel (64 kbps).

Setting Description
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Phone Ports (Enable / Disable) (models with phone ports)

Certain models of the DIVA T/A come equipped with phone ports for connecting analog 
devices such as telephones, fax machines, and modems. Voice calls originating from analog 
devices are carried over ISDN.

Both phone ports are enabled by default. If you are not going to use one or both phone 
ports, it is suggested that you disable them.

Numbers (models without phone ports)

Your ISDN numbers are assigned by your ISDN Service Provider. Depending upon your ISDN 
implementation, you may be given one or two ISDN numbers. The numbers are used by the 
DIVA T/A to identify itself on outgoing calls and to recognize incoming calls which are 
destined for it. 

V.120 The V.120 protocol, more popular in North America, adapts other transmission rates 
to the 64 Kbps ISDN line rate.

V.110 The V.110 protocol, used mostly in Europe, adapts other transmission rates to the 
64 Kbps ISDN line rate. V.110 carries asynchronous data rates from 2.4 to 19.2 Kbps. 

Setting Description
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Phone Port Tabs

These tabs only applies if your DIVA T/A is equipped with analog device ports.

Certain DIVA T/A models provide two phone ports for connecting analog devices such as 
telephones, fax machines, and modems. Voice calls originating from analog devices are 
carried over ISDN.

Since there are two B-channels, the DIVA T/A supports up to two concurrent phone line 
connections, depending on whether there is a data call in place or not. The following method 
applies whenever simultaneous data and voice calls are required:

Data Only. Whenever possible, you should use Multilink PPP since it provides maximum 
throughput with the remote device. You can also configure PPP, V.120, and V.110 protocols. In 
these cases, one B channel is used for data and the other is used for voice.

Data and Voice. When there is only data, Multilink PPP is used as explained above. However, 
one phone line can still be used if Dynamic Bandwidth Allocation (DBA) is enabled. 

For example, if one of your telephones rings while a Multilink PPP data connection is in 
progress, one of the B-channels is automatically dropped, reducing the data connection from 
128 kbps to 64 kbps. The voice call is then connected. When the voice call ends, the 
connection on the second B-channel is re-established, bringing transfer back to 128 kbps. 
The same holds true if you decide to pick up the phone for an outgoing call. This is known as 
‘Call Bumping’.

While a data connection is in progress, only one voice connection can be established in order 
to retain the data connection. In order to use DBA, verify that ‘Dynamic Bandwidth 
Allocation’ is enabled on the ‘Data’ panel.

Two Voice Calls. When both B-channels are used for voice calls, data calls will not be allowed. 
The user will be responsible for any new attempt at placing a Data call.
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Number Assignment

Your ISDN Phone number is assigned by your ISDN Service Provider and is used by the 
DIVA T/A to identify itself on outgoing calls and to recognize incoming calls which are 
destined for it. 

Enter the ISDN number you are going to assign for this Phone Port connection. All calls made 
with this Phone Port will always use the ISDN number you enter here. This can be useful if 
your ISDN billing is broken down by numbers as you can trace the charges relating to a 
specific Phone Port. It is also helpful if your ISDN Service Provider offers a discount on all calls 
made to a favorite number. 

Options

Parameter Description

Call type Specifies the types of calls you will accept on your phone.

• ‘Incoming & Outgoing Calls’: Both incoming and outgoing calls will be accepted on 
the phone.

• ‘Incoming Calls only’: Only incoming calls will be accepted; no outgoing calls can 
be made on the phone.

• ‘Outgoing Calls only’: Only outgoing calls will be permitted; no incoming calls can 
be accepted on this phone.

This phone 
line is used for 
a fax / modem 
only

Enabling this option:

• Enables “3.1KHz Audio”. This specifies that the ISDN network has to preserve the 
quality of the 3.1KHz voice band which is required for data audio signals such as 
faxes and modems.

• Disables supplementary services such as Call Forwarding and Call Waiting.
• Disables Dial Access.

Switch 
distinctive
ring

Distinctive ring specifies that the phone ring will be slightly different to the regular 
ring. By enabling this option, distinctive ring will be switched from the second 
number on your phone port to the first number. 

Use this feature to help differentiate between your two phone numbers, so you can 
tell which phone is ringing. If you only have one number configured on each phone 
port, you can enable this option on one phone port to help differentiate between 
the two phone ports.

If your modem, fax, or telephone is experiencing difficulty in detecting incoming 
voice calls, try toggling the distinctive ring feature.

Enable call 
waiting 
support

Call Waiting alerts you to an incoming call when you are already on the phone. You 
can put one call on hold while you accept another.

The incoming call is often offered using the second B-channel and therefore there 
would be no B-channel available for any other connections. 

If you are using your second B-channel for sending/receiving faxes, you may not 
want Call Waiting enabled. You should disable this option if you do not want Call 
Waiting support to be available on either one or both phone lines.
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Second Number

If you have a second number that you want to use with this Phone Port, enable this option 
and enter the second number in this field.
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Data Tab

This panel allows you to change the ISDN number assignment for your connections. If your 
DIVA T/A has phone ports and the data protocol is set to MultiLink PPP, you also have the 
option of enabling ‘Dynamic Bandwidth Allocation’.

Number Assignment (models with phone ports)

If your DIVA T/A does not have phone ports, see “Number Assignment (models without phone ports)” 
on page 45.

Within the Number Assignment group box, you can either assign a previously configured 
number or numbers to your data ports, or you can enter a unique number to be assigned to 
your data ports for all your data connections. If you select a specific number for your data 
connections, you can then monitor the charges for your data calls. It is also helpful if your 
ISDN Service Provider offers a discount on all calls made to a favorite number. 

Parameter Description

Select a previously 
configured 
number

This option allows you to select from the numbers you previously configured on 
your phone ports. You can select either one number or both numbers and 
assign them to your data ports.

For example, if you select the number that you configured for Phone Port 1, all 
data calls will use this number.

Configure a unique 
number to use for 
your data calls

This option allows you to enter a unique number and assign it to your data 
ports for all your data connections. If you want to enter a unique data number, 
you must request one from your Service Provider. It should only be used for 
data calls and should not be assigned to either of your phone ports.
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Number Assignment (models without phone ports)

If your DIVA T/A is equipped with phone ports, see “Number Assignment (models with phone ports)” 
on page 44.

Within the Number Assignment group box, you can assign a previously configured number 
or numbers to your data ports for all your data connections. If you select a specific number 
for your data connections, you can then monitor the charges for your data calls. It is also 
helpful if your ISDN Service Provider offers a discount on all calls made to a favorite number. 

Protocol Options (models with phone ports)

Parameter Description

Select a previously 
configured 
number

This option allows you to select from the numbers you previously configured. 
You can select either one number or both numbers and assign them to your 
data ports. For example, if you select the first number that you configured, all 
data calls will use that number.

Parameter Description

Dynamic 
Bandwidth 
Allocation (DBA)

This option is visible only if your DIVA T/A is equipped with phone ports and if 
the protocol is set to ‘MultiLink PPP‘, ‘MultiLink PPP with BACP‘, or ‘MultiLink 
with AODI‘.

Dynamic Bandwidth Allocation (DBA) activates the DIVA T/A’s Phone Line 
control for Multilink PPP connections. When activated, this function enables you 
to initiate or receive telephone calls on your regular (non-ISDN) telephone 
without interrupting your Multilink PPP connection. 

The DBA function releases one B-channel, as required for phone calls, without 
interrupting the data link. When the call is over, DBA automatically 
re-establishes the Multilink PPP session by reconnecting the second B-channel, 
if the throughput requires it.
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BACP Tab

This tab is visible only if the data protocol is set to ‘MultiLink PPP with BACP’ or ‘MultiLink PPP 
with AODI’.

BACP activates the DIVA T/A’s automatic traffic monitor for Multilink PPP connections. When 
activated, this DIVA T/A function monitors the send-and-receive traffic volume. BACP opens 
or closes the second B-channel as the traffic volume warrants. Activate this function to 
ensure that two B-channels are never active when one is sufficient.

With AO/DI support, when additional bandwidth is required, BACP automatically adds 
B-channels of 64 Kbps each (for a total of 128 Kbps speed when both B-channels are in use) 
to the connection. When the additional bandwidth is no longer required, one or both 
B-channels are dropped, leaving the D-channel connection in place.

Note:  If you select Bandwidth Allocation Control Protocol, but do not set the timers, you 
could incur unnecessary expense as your second B-channel may open and close frequently, 
costing you the set first-interval amount each time the second B-channel connects.

ISDN Cost Reduction Timers

Set the ISDN Cost Reduction Timers if you intend to establish Multilink PPP connections and 
if you select the Bandwidth Allocation Control Protocol (described above). The ISDN Cost 
Reduction Timers combine with the Bandwidth Allocation Control Protocol to ensure you the 
most cost-efficient use of ISDN online time. With the timers set, the DIVA T/A will not connect 
and disconnect your second B-channel, except when it is most economical to do so.

If your ISDN provider charges one rate for the first interval of time online, and a different rate 
for any subsequent time online, select the appropriate Initial Billing Interval (in seconds) to 
match the amount of time your ISDN provider allocates as the first time interval. Select the 
appropriate Billing Interval to match the amount of time your ISDN provider designates as 
the minimum chargeable unit for all subsequent billing.
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For example, if your ISDN provider charges a particular amount for the first five minutes 
online, select 300 seconds in the Initial Billing Interval field. If your ISDN provider charges 
another amount for each subsequent minute online, select 60 seconds in the Billing Interval 
field.

1st B-Channel

The ‘1st B-Channel’ tab is only visible if the data protocol is set to ‘MultiLink PPP with AODI’.

2nd B-Channel

If you have BACP configured, you can configure these options to specify when the 2nd B-channel will 
be added to the connection as the traffic volume warrants. 

Parameter Description

Delay before 
opening

Specifies the amount of time (in seconds) the throughput on your D-channel must 
exceed the Opening Threshold before the 1st B-channel is added to the AO/DI 
connection.

For example, if you specify 5 seconds, and the Opening Threshold is 70%, once the 
throughput on the D-channel reaches 70%, there will be a delay of 5 seconds before 
the 1st B-channel is added to the AO/DI connection. If the throughput drops below 
70% during the 5 seconds, the 1st B-channel will not be added to the connection.

Opening 
Threshold

Specifies the threshold (percentage) that the throughput on your D-channel must 
exceed before the 1st B-channel is added to the AO/DI connection.

Closing 
Threshold

Specifies the threshold (percentage) that the throughput on your D-channel must be 
below before the 1st B-channel is dropped from the AO/DI connection.

Parameter Description

Delay before 
opening

Specifies the amount of time (in seconds) the throughput on your 1st B-channel 
must exceed the Opening Threshold before the 2nd B-channel is added to the AO/DI 
connection.

For example, if you specify 5 seconds, and the Opening Threshold is 70%, once the 
throughput on the 1st B-channel reaches 70%, there will be a delay of 5 seconds 
before the 2nd B-channel is added to the AO/DI connection. If the throughput drops 
below 70% during the 5 seconds, the 2nd B-channel will not be added to the 
connection.

Opening 
Threshold

Specify the threshold (percentage) that the throughput on your 1st B-channel must 
exceed before the 2nd B-channel is added to the AO/DI connection.

Closing 
Threshold

Specify the threshold (percentage) that the throughput on your 2nd B-channel 
connection must be below before the 2nd B-channel is dropped from the AO/DI 
connection.
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X.25 Tab

This tab is visible only if the data protocol is set to ‘MultiLink PPP with AODI’.

As AO/DI uses the ISDN D-channel X-25 packet service to maintain an “always on” connection 
between you and your Service Provider, there are X.25 parameters that can be configured. 
These are X.25 Facilities and your X.25 Version. This information is provided by your Service 
Provider.

Settings options

Parameter Description

Packet 
Telephone 
Number

A Packet Telephone Number identifies a node on an X.25 network. The address is a 
series of one to fifteen digits. Every X.25 node has a Packet Telephone Number. 

It defines the D-channel's DTE address for communication with the local packet 
handler. This parameter allows the DIVA T/A to activate the D-channel during 
initialization and give its address to the switch. 

This value is assigned by your ISDN provider at subscription time.

X.25 Version ITU (formerly CCITT) reviews and makes international standards recommendations 
for communications protocols. X.25 is a CCITT recommendation for the interface 
between Data Terminal Equipment (DTE) and Data Circuit-Terminating Equipment 
(DCE) for packet-switched data networks (PSDNs).

There are two X.25 CCITT recommendations available for selection, 1984 and 1988. 
This information is provided by your Service Provider and should match the X.25 
recommendation supported on the switch you are connecting to.
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X.25 Facilities options

X.25 facilities are optional network services that let you perform tasks such as reversing 
charges on your calls, accessing a Closed User Group, or specifying a Network User 
Identification (NUI). The options you select must be supported by your Service Provider.

Facilities fall into two groups: those specified at subscription time, and those specified on a 
per-call basis. X.25 Facilities you configure must match your X.25 subscription as agreed with 
your Service Provider. 

The X.25 tab's default parameters are suitable for most configurations. In some cases (such as 
with certain X.25 long distance providers), you might need to modify them. Use the table 
below as a guideline.

Parameter Description

Request 
Reverse 
Charging

Determines who is charged by the X.25 network for the call. Select ‘No’ to pay for the 
call locally, or select ‘Yes’ to charge the remote DTE. Select ‘Yes’ only if the remote 
system accepts reverse charging, otherwise the call may not be accepted.

Throughput 
class 
negotiation

Assigns a ‘Throughput Class’ for the virtual circuit. The Throughput Class specifies 
the effective throughput of the virtual circuit in bits per second (bps). Effective 
throughput may be limited by a number of factors such as level of link utilization, 
network congestion, and host processing.

Select ‘Default’ to use the Throughput Class specified in your network subscription, 
or select one of the values between 75 and 9,600 bps. If you select a ‘bps’ value, the 
local and remote DTEs can negotiate to use a lower value on a per-call basis.

Fast selection Increases the amount of Call User Data that you can include in the Call Request 
packet to 128 bytes, and specifies the type of response requested from the host. Fast 
selection is designed for short-duration, low-volume, transaction-oriented 
applications.

• ‘No’: Turns off Fast Selection.
• ‘Without Restriction’: Host replies with a Call Accept packet that can contain up to 

128 bytes of data. The connection is established and data transfer can occur.
• ‘With Restriction’: Host replies with a Call Clear packet that can contain up to 128 

bytes of data. The connection is terminated.

Closed user 
group 
selection

Specifies the type of closed user group (CUG) subscribed to. CUGs can restrict the set 
of DTEs calls that can be made to or accepted from. Select the option that 
corresponds to the CUG specification in your network subscription.

• ‘None’: Does not subscribe to any CUG.
• ‘Standard’: Subscribes to a CUG. Enter the CUG number in the Group Number box.
• ‘Outgoing Access’: Can receive calls only from members of the CUG, but can make 

calls to any DTE.
• ‘Bilateral’: Can receive calls from or make calls to only a specific DTE.

Group 
number

Specifies the number of the closed user group you have subscribed to. Obtain this 
number from your system administrator or network subscription.
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This is not intended as an exhaustive description of the User Facilities supported either by 
the CCITT or by the network you may be using. For more information, consult the CCITT 
Recommendation International User Services and Facilities in Public Data Networks, Vol. VIII, 
Fascicle VIII.2, Rec. X.2. 

Other Lets you request additional facilities that are not listed in the ‘Common Facilities’ 
group box. Specifies the code for additional facilities that you want to request each 
time the destination makes an X.25 call. Enter facilities as hexadecimal octets 
(eight-bit bytes).

Parameter Description
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Advanced Tab

This tab allows you to configure advanced options, such as call routing.

Call Routing (models with phone ports)

If your DIVA T/A does not have phone ports, see “Call Routing (models without phone ports)” 
on page 52.

Call Routing allows you to specify where your incoming calls should be routed. For example, 
you can specify that any voice calls coming in on your first number are routed to either your 
PC through the serial port or to one of the phone ports on your DIV AT/A. You can also 
specify whether you want your data calls routed to your PC through the serial port or you can 
opt to disable incoming data calls on a specific number.

The options available depend on how you assigned your ISDN numbers and how you 
configured your phone lines. The Calling Routing dialog displays both numbers along with a 
voice and a data drop-down list. The options available from the drop-down lists are 
described below:

Voice Drop Down List

Parameter Description

Phone Port 1 All voice calls to the selected number will be forwarded to Phone Port 1.

Phone Port 2 All voice calls to the selected number will be forwarded to Phone Port 2.

Phone Port 
1&2

All voice calls to the selected number will be forwarded to either Phone Port 1, 
Phone Port 2, or both, depending on availability.

PC All voice calls to the selected number will be forwarded to the PC via the serial port. 

Not Answered Any voice calls to the selected number will not be answered.
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Data Drop Down List

Call Routing (models without phone ports)

If your DIVA T/A is equipped with phone ports, see “Call Routing (models with phone ports)” 
on page 51.

Call Routing allows you to specify where your incoming calls should be routed. For example, 
you can specify that any voice calls coming in on your first number are routed to your PC 
through the serial port or you can opt to disable incoming voice calls on your first number. 
You can also specify whether you want your data calls routed to your PC through the serial 
port or you can opt to disable incoming data calls on a specific number.

The options available depend on how you configured your ISDN numbers. The Calling 
Routing dialog displays both numbers along with a voice and a data drop-down list. The 
options available from the drop-down lists are described below.

Voice and Data Drop Down Lists

Voice To PC

Enabling voice calls to the PC allows you to make or receive voice calls via your PC's serial 
port. If you enable this option, a Voice to PC tab will appear (see “Voice to PC Tab” on 
page 53), where you can select the number(s) you wish to assign to all the voice calls made or 
received via your PC's serial port.

Troubleshooting (United Kingdom only)

This option is only visible if the location is set to ‘United Kingdom’. 

Enable this option if:

• you are in the United Kingdom,
• you are having trouble getting a dial tone on one of your phone lines,
• you are sure your B-channels are available for use,
• your ISDN lines are connected correctly.

Once enabled, you should get a dial tone on your phone line.

Parameter Description

PC All data calls to the selected number are forwarded to the PC via the serial port.

Not Answered Any data calls to the selected number will not be answered.

Parameter Description

PC All voice calls to the selected number will be forwarded to the PC via the serial port. 

Not Answered Any voice calls to the selected number will not be answered.
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Voice to PC Tab

This tab is visible only if the ‘Voice to PC’ option is enabled in the ‘Advanced’ tab. 

The Voice to PC configuration dialog allows you to select the number(s) you wish to assign to 
all the voice calls made or received via your PC's serial port. You can select either both 
numbers or one number. If you select a specific number for your voice calls, you can then 
monitor the charges for your voice calls.

For example, if you select Telephone Number 2, all voice calls made or received via your PC's 
serial port will always use Telephone Number 2. This can be useful if your ISDN billing is 
broken down by numbers as you can trace the charges relating to specific features. 

It is also helpful if your ISDN Service Provider offers a discount on all calls made to a favorite 
number.
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Configuring a Profile using the Wizard

The Configuration Wizard can take you step-by-step through the configuration of a profile. 
To use the Configuration Wizard:

1 Double-click the T/A icon on the taskbar to start the Terminal Adapters program, or click 
‘Start’, ‘Programs’, ‘Eicon DIVA T-A ISDN Modem’, ‘Eicon DIVA Terminal Adapters’.

2 Right-click on the device icon and choose ‘Wizard’. The Configuration Wizard appears.

Note:  To use make changes to one of the other profiles using the Wizard, you must first 
open the ‘Profiles’ window. See “The Profiles Window” on page 35 for more information.

3 Follow the on-screen instructions.

Note:  When you use the Configuration Wizard to configure a profile, you are not shown all 
available parameters (default settings are implemented). If you wish to modify these 
parameters, configure the profile manually using the Configuration Tool.
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The DIVA Terminal Adapters Program for Macintosh computers (System 7 or later) provides 
you with convenient utilities for editing your ISDN settings.

In this chapter:

Introduction....................................................................................................56

About Configuration Profiles....................................................................58

The Profiles Window ....................................................................................59

Configuring a Profile using the Configuration Tool..........................60
Protocol Tab...............................................................................................62
Location Tab ..............................................................................................63
Phone Lines tab .......................................................................................64
BACP Tab.....................................................................................................65
X.25 Tab.......................................................................................................68
Advanced Tab ...........................................................................................70

Configuring a Profile using the Assistant .............................................71
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Introduction

Launching the DIVA Terminal Adapters Program

To launch the Terminal Adapters program, double-click on the DIVA Terminal Adapters icon.

The ‘Eicon DIVA Terminal Adapters Program’ window appears as shown below.

You can launch the Configuration Tool, which allows you to edit your ISDN settings, by 
clicking on the ‘Profiles’ tab, choosing a profile, then clicking the ‘Configure’ button. For more 
information, see “Configuring a Profile using the Configuration Tool” on page 60.

Getting Help

The DIVA Terminal Adapters program offers Balloon Help. To turn it on, select ‘Show Balloons’ 
from the Help menu. When you point the mouse at something that has help associated with 
it, a small balloon will appear with information on that topic.

Menu Bar Commands

The following table describes the commands found in the menu bar.

Select To perform this Action

File > 
Save Configuration

Saves the current device configurations back to your DIVA T/A. If you 
have not made any changes, this command is not available.

File >
Quit

Quits the program. You will be prompted to save your profiles to the 
DIVA T/A if you have not already done so with the ‘Save Configuration’ 
command.

Modem >
Configure

Edits the currently selected profile. To select a profile, click on the 
‘Profile’ tab and then choose a profile from the list in the center of the 
window. You can also click the ‘Configure’ button.

Modem >
Configure Active

Edits the active profile. The active profile is the one selected in the 
‘Active Profile’ area at the bottom of the ‘Profile’ window. Changes made 
to the active profile are automatically written back to the device.

Modem >
Download Firmware

Downloads new firmware. Before downloading new firmware, use the 
‘Export Profiles’ command to save your current configuration to disk. 
See “Updating Firmware” on page 79 for more details.



DIVA T/A ISDN Modem User’s Guide  �  Page 57

The DIVA Terminal Adapters Program for Macintosh

Modem > 
Refresh Modem Info

Scans the serial ports for devices.

Modem >
Factory Default

Reverts your DIVA T/A to the original factory settings. 

Modem >
Remove Device

Removes the currently selected device. The device will not be available 
until detected again, and will be presented as a new device for 
configuration. To detect the device again, use the ‘Refresh Modem Info’ 
command.

Modem >
Import Profiles

Imports a profile file, which contains the three profiles plus other 
configuration parameters. The information is saved to the selected 
device and replaces the current device configuration.

Modem >
Export Profiles

Saves the current device configuration, which includes the three profiles 
plus other configuration parameters, to a profiles file. Before updating 
firmware, it is recommended that you export your current profiles.

Help >
Show Balloons

Shows balloon help. Once on, position the mouse on a field or 
parameter and a brief explanation will appear.

Select To perform this Action
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About Configuration Profiles

A profile is a set of parameters that define a particular ISDN setup. 

When you installed the DIVA software, the Configuration Assistant helped you configure your 
ISDN settings. These settings were saved to Profile 0. 

In addition to this profile, you can configure two other profiles that define different ISDN 
setups, which can correspond to the needs of your different applications. For example, you 
may configure profiles to match the ISDN setup needed to connect to your office, your 
Internet Service Provider (ISP), and CompuServe. 

When you need a particular ISDN configuration, you simply select the appropriate profile. 
This saves you the trouble of reconfiguring all your ISDN parameters each time you switch 
applications. 

Parameter Categories

The different settings are described briefly below. The categories correspond with the panels 
in the Configuration Tool. 

Configuring Profiles

• To configure a profile manually using the Configuration Tool, see page 60.

• To configure a profile using the Configuration Assistant, see page 71.

Protocol This tab specifies your ISDN protocol. For more details, see page 62.

Location This tab specifies the location's ISDN switch type and telephone numbers as 
required. For more details, see page 63.

Phone 
Lines

This tab specifies information about the location's phone lines and is only required if 
your DIVA T/A is equipped with analog device ports. For more details, see page 64.

BACP The BACP tab allows you to specify the Bandwidth Allocation Control Protocol and 
ISDN cost reduction parameters. This tab is visible only if the data protocol is set to 
‘MultiLink PPP’. For more details, see page 65.

X.25 X.25 only applies if AO/DI is supported by your ISDN service provider and if the 
AO/DI option is enabled in the Protocol tab. For more details, see page 68.

Advanced Advanced ISDN parameters such as Dynamic Bandwidth Allocation (DBA). This 
information is optional. For more details, see page 70.



DIVA T/A ISDN Modem User’s Guide  �  Page 59

The DIVA Terminal Adapters Program for Macintosh

The Profiles Window

The Profiles window allows you to edit any of the three profiles using the Configuration Tool 
or Configuration Assistant. You can also rename profiles or set the active profile. 

To open the Profiles window:

1 Launch the DIVA Terminal Adapter Program.

2 Click on the ‘Profiles’ tab.

3 Select ‘Save’ from the ‘File’ menu. The changes are written to the device, the DIVA T/A 
restarts automatically, and the profile you selected in previous step is implemented. Your 
DIVA T/A is ready for use.

If you want to... Then do this

Configure a profile 
manually

Select a profile from the ‘Profiles’ list in the center of the window, then 
click the ‘Configure’ button. For more information, see page 60.

Configure a profile 
using the Assistant

Select a profile from the ‘Profiles’ list in the center of the window, then 
click the ‘Assistant’ button. For more information, see page 71.

Rename a profile Select a profile from the ‘Profiles’ list in the center of the window, then 
click the ‘Rename’ button.

Set the active profile Select a profile from the ‘Active Profile’ list at the bottom of the window, 
then click ‘OK’. 

The active profile is the profile the DIVA T/A uses when powering up. The 
Configuration Tool also opens the active profile when you double-click 
on the device icon, as does the Wizard when you run it from the File 
menu.
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Configuring a Profile using the Configuration Tool

To configure a profile manually using the Configuration Tool:

1 Launch the DIVA Terminal Adapter Program.

2 Click on the ‘Profiles’ tab. Three default profiles are available: Profile 0, Profile 1, and 
Profile 2. Profile 0 was modified using the Configuration Assistant when you ran the DIVA 
Terminal Adapters program for the first time.

If you wish to rename a profile, select the profile from the list and click ‘Rename’.

3 Select the profile from the list and click ‘Configure.’ The Configuration Tool dialog 
appears. By default, the Protocol tab is displayed.
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4 Go through each panel and make your changes. To move from panel to panel, click on 
the tabs at the top of the window. Note that some tabs are not available unless certain 
options are configured. For example, the ‘X.25’ tab is not available unless ‘Enable Always 
On / Dynamic ISDN’ is checked in the ‘Protocol’ tab.

Parameters are explained on the following pages: 

Protocol Tab ......................................... 62
Location Tab......................................... 63
Phone Lines tab .................................. 64
BACP Tab ............................................... 65
X.25 Tab ................................................. 68
Advanced Tab...................................... 70

5 Click ‘OK’.

6 If you want the profile to be active when you restart the DIV AT/A, select its name from 
the ‘Active Profiles’ pick list.

7 Select ‘Save’ from the ‘File’ menu. The changes are written to the device, the DIVA T/A 
restarts automatically, and the profile you selected in previous step is implemented. Your 
DIVA T/A is ready for use.

8 After the DIVA T/A has restarted, check the ‘D’ and ‘Link’ LED on the front panel of the 
DIVA T/A. If the LEDs are steady, the DIVA T/A is working correctly; if they are not steady, 
check your configuration and try again. Note that, in Europe, an inactive ‘Link’ LED 
indicates an idle condition. For more details on the LEDs, see “LED Status Indicators on 
the DIVA T/A” on page 132. 

For information on using your DIVA T/A modem, see “Using the DIVA T/A” on page 84.
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Protocol Tab

The Protocol tab lets you choose the protocol settings for your ISDN line.

By default, 'PPP' is enabled. Both ‘PPP’ and ‘Multilink PPP’ require that a PPP communications 
stack be installed on your computer. Note that the protocol you choose must match the 
protocol on the receiving system.

About the Protocol panel 

• For the ‘Enable Always On / Dynamic ISDN (AO/DI)’ option to be available, the protocol 
must be set to ‘MultiLink PPP’. Also, AO/DI is only available if you have subscribed to it; 
check with your ISDN Service Provider.

• For the ‘BACP’ tab to be visible (see page 65), the protocol must be set to ‘MultiLink PPP’.

• For the ‘X.25’ tab to be visible (see page 68), the ‘Enable Always On / Dynamic ISDN 
(AO/DI)’ option must be enabled.

About MultiLink PPP

• To obtain maximum performance when using the MultiLink PPP protocol, your 
computer's serial port should be capable of 230.4 kbps transfer. Macintosh computers 
that have serial ports capable of 230.4 kbps include all PowerMacintosh computers 
(except for the 52xx, 62xx, and 6300 models) and AV Macintosh computers. Check the 
user manual that came with your system or consult Apple's technical library at 
http://til.info.apple.com/.

• Multilink PPP does not support the callback feature used by some servers.

• When using Multilink PPP for incoming calls, only SPAP or PAP authentication are 
supported.
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Location Tab

The ‘Location’ tab contains information on your ISDN switch type and telephone numbers. 

Use the table below as a guideline for setting these parameters.

Parameter Description

Switch Type Specifies the ISDN switch type used by your ISDN service provider.

Your choices are Europe (EuroISDN), Australia (MicroLink), Australia (OnRamp), 
Japan (INS-Net64), China ISDN, and Singapore ISDN. Default: Europe (EuroISDN).

Use 2 
Numbers

Activates the ‘2nd Number’ tab. Use the second number tab if your ISDN 
provider assigns two numbers. 

Telephone 
Number 
(1st Number/ 
2nd Number)

Specifies your Directory Numbers. If your line supports Multiple Subscriber 
Numbers (MSNs), the DIVA T/A handles incoming calls differently, depending 
on what you enter in the Telephone Number fields. 

• If you do not specify a number in either the ‘1st Number’ or ‘2nd Number’ 
fields, all ports (PHONE 1, PHONE 2, and ISDN) answer both directory 
numbers.

• If you specify a number in the ‘1st Number’ field but leave the ‘2nd Number’ 
field empty, all ports (PHONE 1, PHONE 2, and ISDN) answer only calls to the 
specified number.

• If you specify one number in the ‘1st Number’ field, and a different number in 
the ‘2nd Number’ field, PHONE 1 answers only calls to the first number; 
PHONE 2 answers only calls to the second number; and the ISDN port answer 
calls to either the 1st or 2nd number.

DTE Address This field only applies if AO/DI supported by your ISDN service provider and if 
‘Enable Always On / Dynamic ISDN’ is enabled (see page 62). 

An X.25 DTE Address identifies a node on an X.25 network. The address is a 
series of one to fifteen digits. Every X.25 node has an X.25 address. 

Your service provider assigns this value at subscription time.
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Phone Lines tab

This tab contains information on your phone lines.

Use the table below as a guideline for setting these parameters.

Parameter Description

This phone 
line is used 
for a fax / 
modem only

Selecting this option:

• Enables ‘3.1KHz Audio’. This specifies that the ISDN network has to preserve 
the quality of the 3.1KHz voice band that is required for data audio signals 
such as faxes and modems. 

• Disables calling features such as Call Forward and Call Waiting.
• Disables Dial Access.

Enable 
distinctive 
ring

Specifies that the phone ring will be slightly different from the regular ring. If 
your modem, fax, or telephone is experiencing difficulty detecting incoming 
voice calls, try toggling the distinctive ring feature.

Region Specifies the country where you are located. This ensures that the DIVA T/A 
implements the ring pattern (and other analog device parameters) suited to 
your country. If your country is not listed, use the default, International.

If problems persist, try configuring this parameter using the AT commands 
AT*F and AT!L. See the ‘DIVA T/A Reference Guide’ for more information.
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BACP Tab

This tab allows you to configure the BACP options you want implemented on your DIVA T/A. 
Note that this tab is visible only if the protocol is set to ‘MultiL inkPPP’.

Use the table below as a guideline for setting these parameters.

Parameter Description

BACP/BOD 
(Bandwidth 
Allocation 
Control 
Protocol / 
Bandwidth 
on Demand)

This option only applies if your ISDN connection protocol is set to ‘Multilink PPP’. 

‘BACP/BOD’ activates the DIVA T/A's automatic traffic monitor for Multilink PPP 
connections. When activated, this DIVA T/A function monitors the 
send-and-receive traffic volume. 

Without AO/DI support: ‘BACP’ opens or closes the second B-channel as the 
traffic volume warrants. Activate this function to ensure that two B-channels are 
never active when one is sufficient. 

With AO/DI support: When additional bandwidth is required, ‘BACP’ 
automatically adds B-channels of 64 Kbps each (for a total of 128 Kbps speed 
when both B-channels are in use) to the connection. When the additional 
bandwidth is no longer required, one or both B-channels are dropped, leaving 
the D-channel connection in place. 

Note:  Be sure to configure the ‘Cost Reduction Timers’ (see next option) to avoid 
numerous first interval charges. If you select ‘BACP’, but do not set the ‘Cost 
Reduction Timers’, you could incur unnecessary expense as your second 
B-channel might open and close frequently, costing you the first-interval amount 
each time the second B-channel connects. 

Default: ‘BACP/BOD’ disabled.



DIVA T/A ISDN Modem User’s Guide  �  Page 66

The DIVA Terminal Adapters Program for Macintosh

ISDN Cost 
Reduction 
Timers

This option only applies if your ISDN connection protocol is set to ‘Multilink PPP’. 

Note:  You must activate ‘BACP/BOD’ before setting the intervals. 

Set these intervals to ensure your second B-channel is used most economically.

‘Initial Billing Interval’: Specifies the minimum time a B-channel can remain 
open (in seconds). For example, if the value is set to 600, a channel, once open, 
will remain open for at least 10 minutes (600 seconds). 

If you are charged a fixed amount for the first x seconds of a call (e.g. 300 
seconds), a good rule of thumb is to set the timer to this value, e.g. 300. For an 
example of setting the interval under more advanced conditions, see “Billing 
Interval Example” on page 137. 

Setting the timer to 0 disables it. The Billing Interval is also, effectively disabled. 

Default: 60 seconds. 

‘Billing Interval’: Specifies the time interval your Service Provider uses to bill 
usage of your ISDN line (in seconds). For example if your Provider charges $Y per 
60 seconds, enter 60. 

Setting the timer to 0 disables it. The Initial Billing Interval remains in effect. 

Default: 60 seconds.

1st B-channel ‘Delay before opening’: Specifies the amount of time (in seconds) the 
throughput on your D-channel must exceed the Opening Threshold before the 
1st B-channel is added to the AO/DI connection. 

For example, if you specify 5 seconds, and the Opening Threshold is 70%, once 
the throughput on the D-channel reaches 70%, there will be a delay of 5 seconds 
before the 1st B-channel is added to the AO/DI connection. If the throughput 
drops below 70% during the 5 seconds, the 1st B-channel will not be added to 
the connection. 

‘Opening Threshold’: Specifies the threshold (percentage) that the throughput 
on your D-channel must exceed before the 1st B-channel is added to the AO/DI 
connection. 

‘Closing Threshold’: Specifies the threshold (percentage) that the throughput 
on your B-channel must be below before the 1st B-channel is dropped from the 
AO/DI connection. 

This option is only available with AO/DI support.

Parameter Description
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2nd 
B-channel

‘Delay before opening’: Specifies the amount of time (in seconds) the 
throughput on your 1st B-channel must exceed the Opening Threshold before 
the 2nd B-channel is added to the AO/DI connection. 

For example, if you specify 5 seconds, and the Opening Threshold is 70%, once 
the throughput on the 1st B-channel reaches 70%, there will be a delay of 5 
seconds before the 2nd B-channel is added to the AO/DI connection. If the 
throughput drops below 70% during the 5 seconds, the 2nd B-channel will not 
be added to the connection. 

‘Opening Threshold’: Specifies the threshold (percentage) that the throughput 
on your 1st B-channel must exceed before the 2nd B-channel is added to the 
AO/DI connection. 

‘Closing Threshold’: Specifies the threshold (percentage) that the throughput 
on your 2nd B-channel connection must be below before the 2nd B-channel is 
dropped from the AO/DI connection. 

Note:  This option is available without AO/DI support. If you have BACP 
configured, you can configure this option to specify when the 2nd B-channel will 
be added to the connection as the traffic volume warrants. 

Parameter Description
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X.25 Tab

This tab allows you to configure X.25 settings. Note that this tab is visible only if the protocol 
is set to ‘MultiLink PPP’ and if ‘Enable Always On / Dynamic ISDN (AO/DI)’ is enabled.

The X.25 tab's default parameters are suitable for most configurations, but in some cases 
(such as with certain X.25 long distance providers), you may need to modify them. Use the 
table below as a guideline.

Parameter Description

X.25 Version There are two X.25 CCITT recommendations available for selection, ‘1984’ and 
‘1988’. This information is provided by your Service Provider and should match the 
X.25 recommendation supported on the switch you are connecting to.

Request 
Reverse 
Charging

Determines who is charged by the X.25 network for the call. Select ‘No’ to pay for 
the call locally, or select ‘Yes’ to charge the remote DTE. Select ‘Yes’ only if the 
remote system accepts reverse charging, otherwise the call may not be accepted.

Throughput 
class 
negotiation

Assigns a ‘Throughput Class’ for the virtual circuit. The Throughput Class specifies 
the effective throughput of the virtual circuit in bits per second (bps). Effective 
throughput may be limited by a number of factors such as level of link utilization, 
network congestion, and host processing.

Select ‘Default’ to use the Throughput Class specified in your network subscription, 
or select one of the values between 75 and 9,600 bps. If you select a ‘bps’ value, the 
local and remote DTEs can negotiate to use a lower value on a per-call basis.
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Fast 
selection

Increases the amount of Call User Data that you can include in the Call Request 
packet to 128 bytes, and specifies the type of response requested from the host. 
Fast selection is designed for short-duration, low-volume, transaction-oriented 
applications.

• ‘No’: Turns off Fast Selection.
• ‘Without Restriction’: Host replies with a Call Accept packet that can contain up 

to 128 bytes of data. The connection is established and data transfer can occur.
• ‘With Restriction’: Host replies with a Call Clear packet that can contain up to 

128 bytes of data. The connection is terminated.

Closed user 
group 
selection

Specifies the type of closed user group (CUG) subscribed to. CUGs can restrict the 
set of DTEs calls that can be made to or accepted from. Select the option that 
corresponds to the CUG specification in your network subscription.

• ‘None’: Does not subscribe to any CUG.
• ‘Standard’: Subscribes to a CUG. Enter the CUG number in the Group Number 

box.
• ‘Outgoing Access’: Can receive calls only from members of the CUG, but can 

make calls to any DTE.
• ‘Bilateral’: Can receive calls from or make calls to only a specific DTE.

Group 
number

Specifies the number of the closed user group you have subscribed to. Obtain this 
number from your system administrator or network subscription.

Others Lets you request additional facilities that are not listed in the ‘Common Facilities’ 
group box. Enter a code for additional facilities you want to request each time the 
destination makes an X.25 call. Codes must be hexadecimal octets (eight-bit 
bytes).

Parameter Description
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Advanced Tab

This tab allows you to configure advanced options you want implemented on your DIVA T/A.

Use the table below as a guideline for setting these parameters.

Parameter Description

DBA 
(Dynamic 
Bandwidth 
Allocation)

This option only applies if your ISDN connection protocol is set to ‘Multilink PPP’. 

Note:  Only available on models equipped with analog device ports. 

When activated, this function lets you initiate or receive telephone calls on your 
regular (non-ISDN) telephone without interrupting your current connection. It 
releases one B-channel, as required for analog device calls, without interrupting 
the data link. (This is referred to as ‘call bumping’.) After you hang up, the B-channel 
is automatically brought back up for your current connection.

Default: ‘DBA’ Enabled.

Update 
Time

If you have a phone with call display and are receiving calls with the incorrect time 
or date, click the ‘Update Time’ button. The DIVA T/A uses the computer’s clock to 
update the date and time. 

If you power off your DIVA T/A, click ‘Update Time’ when you turn it back on. This 
assures that the correct date and time are set.
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Configuring a Profile using the Assistant

The Configuration Assistant can take you step-by-step through setting the parameters 
required for your ISDN network connection. To use the Assistant:

1 Launch the DIVA Terminal Adapter Program.

2 Click on the ‘Profiles’ tab. Three default profiles are available: Profile 0, Profile 1, and 
Profile 2. Profile 0 was modified using the Configuration Assistant when you ran the 
DIVA Terminal Adapters program for the first time.

3 Select a profile from the list and click ‘Assistant.’ The Configuration Assistant window 
appears. Follow the on-screen instructions.

4  When the ‘Congratulations’ screen appears, setup is complete. Click ‘Finish’.
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5 You are returned to the DIVA Terminal Adapters program.

6 If you want the profile to be active when you restart the DIV AT/A, select its name from 
the ‘Active Profiles’ pick list.

7 Select ‘Save’ from the ‘File’ menu. The changes are written to the device, the DIVA T/A 
restarts automatically, and the profile you selected in previous step is implemented. 
Your DIVA T/A is ready for use.

Note:  When you use the Configuration Assistant to configure a profile, you cannot set 
‘Phone Lines’ and ‘Advanced’ ISDN parameters (default settings are implemented). If you 
want to modify these parameters, configure the profile manually using the Configuration 
Tool.
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The VT100 Configuration Tool is included in your DIVA T/A firmware and can be used to 
configure your ISDN settings on any computer platform. To access the VT100 Configuration 
Tool, you need a VT100-compatible terminal emulation program such as Telix, HyperAccess, 
or Zterm.

1 Start the VT100-compatible terminal emulation program. Set the parameters of your 
VT100 terminal emulation program using the table below as a guideline:

Terminal Emulation Type: VT100/VT102
Local Echo: Off
CR Translation: CR
LF after CR: Off

2 Verify that the terminal-emulation program uses the same COM port as that assigned to 
the DIVA T/A.

3 Enter the following command at the prompt and press Enter:

AT@MENU

The main VT100 Configuration Tool screen opens:

*-----------------------------------------------------------------------------*
|            DIVA T/A ISDN Modem - International   Version 2.2                |
|               Copyright © 1999 Eicon Technology Corporation                 |
+-------------------------------------------------------------+---------------+
|MENU: Main menu                                              |Choice:        |
|                                                             |Current profile|
|             Open Profile:  Current profile                  |Profile 0      |
|                                                             |Profile 1      |
|          ISDN Parameters:  < press Enter >                  |Profile 2      |
|                 Protocol:  PPP async/sync                   |Factory profile|
|               Phone Line:  < press Enter >                  |               |
|                 Advanced:  < press Enter >                  |               |
|                                                             |               |
|          Powerup Profile:  Profile 0                        |               |
|             Save Profile:  Profile 0                        |               |
|             Restart Unit:  Profile 0                        |               |
|                      Quit                                   |               |
|<ESC> Quit                                                   |               |
+-----------------------------------HELP----------------------+---------------+
| Selects which profile to open: current, stored (0,1,2) or factory.          |
|  -Loads the current profile.                                                |
*-----------------------------------------------------------------------------*
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Navigating in the VT100 Configuration Tool screen 
The following table describes the function keys that let you navigate the VT100 
Configuration Tool’s screen:

4 From ‘Open Profile’ in the main menu, use the pull-down list to select the profile you 
want to configure.

5 In the ‘Protocols’ field of the main menu, specify the B-channel protocol you want to use 
(note that the protocol must match the protocol on the receiving system). For most 
connections, the default ‘PPP’ (for single B-channel connections) should be used. If the 
default is not supported, use ‘MultiLink PPP’, ‘V.110’, or ‘V.120’. Both ‘PPP’ and ‘Multilink 
PPP’ require that a PPP communications stack be installed on your computer.

Note:  To obtain maximum Multilink PPP performance, your computer's serial port 
should be capable of 230.4 kbps transfer. On an IBM-compatible PC, you need a UART 
16650 (versus 115.2 kbps with 16550).  Macintosh computers that have serial ports 
capable of 230.4 kbps include all PowerMacintosh computers (except for the 52xx, 62xx, 
and 6300 models) and AV Macintosh computers.

Warning:    When using Multilink PPP for incoming calls, only SPAP or PAP authentica-
tion are supported.

Key Function

Up arrow Moves the cursor to the previous field.

Down arrow Moves the cursor to the next field.

Right arrow Displays the sub-menu level. In a text field, it moves the cursor one character 
to the right. 

Left arrow Displays the previous menu level. In a text field, it moves the cursor one 
character to the left.

Enter Validates the configuration setting and displays the next field, or displays the 
next menu.

Tab Displays the next field.

Space bar Displays the next choice available (in fields offering multiple choices).

F2 Selects a specific field. Press F2, and enter the letter corresponding to the field 
you want to edit.

F4 Toggles between text and graphics modes (text mode is the default).

ESC Cancels your configuration setting (if a change was made) or moves to the 
previous menu level (if no change was made).
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6 Select ‘ISDN Parameters’ and press Enter.

*-----------------------------------------------------------------------------*
|            DIVA T/A ISDN Modem - International Version 2.2                  |
|               Copyright © 1999 Eicon Technology Corporation                 |
+-------------------------------------------------------------+---------------+
|MENU: ISDN Parameters                                        |Choice:        |
|                                                             |Euro ISDN      |
|      Switch Type: Euro ISDN                                 |Microlink      |
|FIRST NUMBER                                                 |INS-Net64      |
|    Directory Number                                         |OnRamp         |
|                                                             |China ISDN     |
|                                                             |Singapore ISDN |
|                                                             |               |
|                                                             |               |
|SECOND NUMBER                                                |               |
|    Directory Number                                         |               |
|                                                             |               |
|                                                             |               |
|                                                             |               |
|<ESC> Previous menu                                          |               |
+-----------------------------------HELP----------------------+---------------+
| Sets the appropriate switch type to use during unit initialization.         |
|                                                                             |
|                                                                             |
*-----------------------------------------------------------------------------*

Configure the following parameters:

7 After configuring the ISDN parameters, press Escape to exit the ‘ISDN Parameters’ menu.

Parameter Description

Switch Type Specifies the ISDN switch type used by your ISDN service provider.

Your choices are Europe (Euro ISDN), Japan (INS-Net64), China ISDN, 
Singapore ISDN, and, for Australia, TPH1962 (Microlink) and Euro ISDN 
(OnRamp). Default: Europe (EuroISDN).

Note:  If you select China ISDN as the Switch Type, the Region parameter (on 
the Phone Lines screen) will automatically be set to China. 

Directory 
Number 
(1st/2nd 
Number)

Specifies your ISDN number. If your line supports Multiple Subscriber 
Numbers (MSNs), the DIVA T/A handles incoming calls differently, depending 
on what you enter in the Directory Number field(s). 

• If you do not specify a number in either the ‘1st Number’ or ‘2nd Number’ 
fields, all ports (PHONE 1, PHONE 2, and ISDN) answer all ISDN numbers 
assigned to your line.

• If you specify a number in the ‘1st Number’ field but leave the ‘2nd Number’ 
field empty, all ports (PHONE 1, PHONE 2, and ISDN) answer only calls to the 
specified number.

• If you specify one number in the ‘1st Number’ field, and a different number 
in the ‘2nd Number’ field, PHONE 1 answers only calls to the first number; 
PHONE 2 answers only calls to the second number; and the ISDN port 
answer calls to either the 1st or 2nd number.
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8 Models equipped with analog device ports: From the main menu, select ‘Phone Line’ and 
press Enter to open the configuration screen.

*-----------------------------------------------------------------------------*
|             DIVA T/A ISDN Modem - International Version 2.2                 |
|               Copyright © 1999 Eicon Technology Corporation                 |
+-------------------------------------------------------------+---------------+
| MENU: Phone Line                                            |Choice:        |
|                                                             |Yes            |
| Phone 1                                                     |No             |
|        Use modem/fax only: No                               |               |
|   Enable distinctive ring: No                               |               |
|                                                             |               |
| Phone 2                                                     |               |
|        Use modem/fax only: No                               |               |
|   Enable distinctive ring: No                               |               |
|                                                             |               |
|                                                             |               |
|                                                             |               |
|                    Region: International                    |               |
|                                                             |               |
|                                                             |               |
|<ESC> Previous menu                                          |               |
+-----------------------------------HELP----------------------+---------------+
| Set supplementary services for this Phone port.                             |
|  -ISDN Bearer Capability is set for Speech during voice calls               |
|   on the Phone ports.
*-----------------------------------------------------------------------------*

The following parameters can be configured:

9 After configuring the parameters, press Escape to exit the ‘Phone Line’ menu.

Parameter  Description

Use 
modem/fax 
only

Enabling this option causes the following: 

• Enables ‘3.1KHz Audio’. This specifies that the ISDN network has to preserve 
the quality of the 3.1KHz voice band that is required for data audio signals 
such as faxes and modems. 

• Disables calling features such as Call Forward and Call Waiting. 
• Disables Dial Access.

Enable 
distinctive 
ring

Specifies that the phone ring will be slightly different from the regular ring. If 
your modem, fax, or telephone is experiencing difficulty detecting incoming 
voice calls, try toggling the distinctive ring feature.

Region Specifies the country in which you are situated. This ensures that the DIVA T/A 
implements the ring pattern (and other analog device parameters) suited to 
your country. If your country is not listed, use the default, International.

If problems persist, advanced users might also want to try and configure this 
parameter using the AT commands AT*F and AT!L. See the ‘DIVA T/A 
ISDN Modem Reference Guide’ for more information.

Note:  If you select China as the Region, the Switch Type parameter (on the 
ISDN Parameters screen) will automatically be set to China ISDN. 



DIVA T/A ISDN Modem User’s Guide  �  Page 77

The VT100 Configuration Tool

10 From the main menu, select ‘Advanced’ and press Enter.

*-----------------------------------------------------------------------------*
|               DIVA T/A ISDN Modem - International Version 2.2               |
|               Copyright © 1999 Eicon Technology Corporation                 |
+-------------------------------------------------------------+---------------+
|MENU: Advanced                                               |               |
| Number/Feature association < press Enter >                  |               |
|                                                             |               |
|                                                             |               |
|               Enable DBA:  Yes                              |               |
|          Enable BACP/BOD:  No                               |               |
|                                                             |               |
| Initial Billing Interval:  60                               |               |
|         Billing Interval:  60                               |               |
|                                     ( 05-17-1999 )          |               |
|              Update Date:           ( 15:18:48 )            |               |
|              Update Time:                                   |               |
|                                                             |               |
|<ESC> Previous menu                                          |               |
+-----------------------------------HELP----------------------+---------------+
| Allows you to configure the association between your phone numbers and the  |
| features of your terminal adapter which respond to them.                    |
|                                                                             |
|                                                                             |
*-----------------------------------------------------------------------------*

Configure the following parameters as required:

Parameter  Description

Number / 
Feature 
Association

Choosing this option will bring up the Number / Feature Association menu. This 
menu allows you to choose which ports will respond to which ISDN numbers. 
For example, if you have phone ports on your DIVA T/A, you may want to 
designate calls dialed to directory number 1 to be answered by phone port 1, 
and calls dialed to ISDN number 2 to be answered by phone port 2.

Enable DBA 
(Dynamic 
Bandwidth 
Allocation)

This option only applies if your ISDN connection protocol is set to ‘Multilink PPP’. 

Note:  Only available on models equipped with analog device ports. 

When activated, this function lets you initiate or receive telephone calls on your 
regular (non-ISDN) telephone without interrupting your current connection. It 
releases one B-channel, as required for analog device calls, without interrupting 
the data link. After you hang up, the B-channel is automatically brought back up 
for your current connection. 

Default: ‘DBA’ enabled.

Enable 
BACP/BOD 
(Bandwidth 
Allocation 
Control 
Protocol / 
Bandwidth 
on Demand)

This option only applies if your ISDN connection protocol is set to ‘Multilink PPP’.

‘BACP/BOD’ activates the DIVA T/A's automatic traffic monitor for multilink PPP 
Connections. When activated, this function monitors the send-and-receive traffic 
volume, and opens or closes your second B-channel as the traffic volume 
warrants. Activate this function to ensure that two B-channels are never active 
when one is sufficient, thus reducing the chargeable time payable (see next 
option) to your ISDN provider.

Note:  Be sure to activate the ‘Cost Reduction Timers’ to avoid numerous first 
interval charges. If you select ‘BACP/BOD’, but do not set the ‘Cost Reduction 
Timers’, you could incur unnecessary expense as your second B-channel might 
open and close frequently, costing you the first-interval amount each time the 
second B-channel connects. 

Default: ‘BACP/BOD’ disabled.
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11 After completing the advanced parameters configuration, press Escape to exit the 
‘Advanced’ menu.

12 From the main menu, select ‘Save Profile’ and press Enter to save the changes made to 
the profile.

13 Select ‘Restart’. Verify that the correct startup profile is specified, then press Enter.

After the DIVA T/A has restarted, check that the ‘D’ and Link LEDs on the DIV AT/A's front 
panel. If the LEDs are steady, the DIVA T/A is working correctly; if they are not steady, check 
your configuration and try again. Note that, in Europe, an inactive ‘Link’ LED indicates an idle 
condition. For more details on the LEDs, see “LED Status Indicators on the DIVA T/A” on 
page 132. 

Your DIVA T/A is configured for ISDN. Close your VT-100 application. Go to “Using the 
DIVA T/A” on page 84.

Initial Billing 
Interval

Billing 
Interval

This option only applies if your ISDN connection protocol is set to ‘Multilink PPP’.

Note:  You must activate ‘BACP/BOD’ before setting the intervals. 

Set these intervals to ensure your second B-channel is used most economically. 

‘Initial Billing Interval’: Specifies the minimum time a B-channel can remain 
open (in seconds). For example, if the value is set to 600, a channel, once open, 
will remain open for at least 10 minutes (600 seconds). 

If you are charged a fixed amount for the first x seconds of a call (e.g. 300 
seconds), a good rule of thumb is to set the interval to this value, e.g. 300. For an 
example of setting the intervals under more advanced conditions see “Billing 
Interval Example” on page 137. 

Setting the interval to 0 disables it. The Billing Interval is also effectively disabled. 

Default: 60 seconds. 

‘Billing Interval’: Specifies the time interval your Service Provider uses to bill 
usage of your ISDN line (in seconds). For example, if your Provider charges $Y per 
60 seconds, enter 60. For an example of setting the Interval under more 
advanced conditions see “Billing Interval Example” on page 137. 

Setting the interval to 0 disables it. The Initial Billing Interval remains in effect. 

Default: 60 seconds.

Update Date

Update Time

Models equipped with analog device ports only. 

If you have a phone with call display and are receiving calls with the incorrect 
time or date, use ‘Update Date’ and ‘Update Time’ to reset the date and calendar. 

If you power off the DIVA T/A, you should use ‘Update Date’ and ‘Update Time’ 
when you turn it back on. This assures that the correct date and time are set on 
the DIVA T/A.

Parameter  Description
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This chapter contains procedures for loading new firmware into your DIVA T/A. The 
procedure you use depends on your computer platform.

Windows 95/98/NT................................ 80
Macintosh (System 7 or Later)........... 81
Other Operating Systems ................... 82
Updating the DIVA T/A INF file.......... 83
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Windows 95/98/NT

When you download new firmware, the DIVA T/A will ask you if you want to export your 
current profiles. It is recommended that you export the profiles. This assures you have a 
backup available in the event the profiles are lost during the download. If the profiles do get 
lost, use the Import Profile command and copy the exported profiles back to the device.

To update your firmware:

1 Launch the DIVA Terminal Adapters program.

2 Select the device to which you are going to download new firmware.

3 From the ‘File’ menu, select ‘Download Firmware’ (or right click your mouse, and then 
select ‘Download Firmware’).

4 Click ‘Export’ if you wish to export your current files to disk, or click ‘OK’ to skip this step.

5 Select the device with the required firmware and click ‘OK’. If necessary click ‘Have 
Firmware’, specify the path to the firmware, and click ‘Open’. 

6 Click ‘Yes’ when prompted if you want to continue. The new firmware will download to 
the device. This will take a few minutes.

7 Click ‘OK’ when the download is complete. The device will automatically be restarted.
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Macintosh (System 7 or Later)

When you download new firmware, the DIVA T/A will ask you if you want to export your 
current profiles. It is recommended that you export the profiles. This assures you have a 
backup available in the event the profiles are lost during the download. If the profiles do get 
lost, use the Import Profile command and copy the exported profiles back to the device.

To update your firmware:

1 Launch the DIVA Terminal Adapters program.

2 Select the device to which you are going to download new firmware.

3 From the ‘Modem’ menu, select ‘Download Firmware’.

4 Click ‘Export’ if you wish to export your current files to disk, or click ‘OK’ to skip this step.

5 Select one of the firmware files from the list. These files are located in the ‘ELMs’ folder of 
the ‘DIVA Terminal Adapters’ folder. If you wish to choose a firmware file from another 
location, click ‘Browse’. 

6 Click ‘OK’ to start the download. This will take a few minutes.

Note:  When downloading new firmware, do not open another application until the 
process is complete. Doing so may cause the download to time out.

7 Click ‘OK’ when the download is complete. The device is automatically be restarted.
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Other Operating Systems

Procedure for updating the firmware using Windows 3.x, Windows for Workgroups 
3.11, DOS, OS/2, Macintosh (prior to System 7), and Others

When you update your DIVA T/A firmware, the current profile configurations might get 
erased. It is recommended, therefore, that you record your current settings and SPID 
numbers before updating (use the AT command AT&V or AT@MENU with any terminal 
emulation program to view the current settings).

To update your DIVA T/A:

1 Start a terminal-emulation software application capable of X-Modem or 1K-Xmodem 
(faster) transfer.

2 Configure the terminal to talk to the DIVA T/A ISDN Modem.

3 Type AT$Z.

4 Type at@load (this command is case sensitive).

5 Start the X-Modem transfer.

6 Select the firmware file required by your model of DIVA T/A from wherever it is located 
(your \TEMP directory, for example). Firmware files can also be found in the \FIRMWARE 
directory of your DIVA T/A CD.

Note:  The firmware file you need to use will depend on the DIVA T/A model. Use the 
diagrams below to identify the firmware file you should use.

Use TABOXROW.ELM if you have a DIVA T/A model similar to the following diagrams.

  

Use TABLCROW.ELM if you have a DIVA T/A model similar to the following diagrams.

7 Wait for the reply that denotes successful transfer. The DIVA T/A will restart 
automatically.

Warning:    Powering off the DIVA T/A immediately following the transfer could damage 
your DIVA T/A. Wait a few moments before powering off your DIVA T/A. 

8 If required, reconfigure your DIVA T/A.

Phone ports next to ISDN port

ISDN
Phone 1 Phone 2 Serial

Reset

ISDN port, a space,
then the serial port

ISDN
Serial

Reset

Reset

ISDN
Phone 1 Phone 2Serial

Serial port next to ISDN port

Reset

ISDN
Serial

Serial port next to ISDN port
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Updating the DIVA T/A INF file

Procedure for Windows 3.x, Windows for Workgroups 3.11, and Windows NT 3.51

This section only applies if you are using RAS.

To update the DIVA T/A INF file:

1 Open any text editor.

2 Open the file MODEM.INF found in the Windows\System directory for Windows 3.x or 
Windows\System32\RAS directory for Windows NT 3.51, and remove all sections relating 
to the DIVA T/A ISDN Modem.

3 Open the updated file WFWNTEI2.INF.

4 Copy the contents of WFWNTEI2.INF and append it to the end of the MODEM.INF file; 
save the appended MODEM.INF file, and exit your text editor.

5 (Windows NT only). From the RAS setup, remove the ‘Eicon DIVA T/A ISDN Modem’ and 
then restore it. Refer to RAS online help for information on removing and adding 
modems.
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Once you have installed and configured DIVA T/A, you can dial into your office LAN, access 
the Internet, as well as exchange data/faxes with any remote ISDN or analog equipment. 
Before attempting this, make sure that your PC is equipped with remote-access client 
software such as Dial-Up Networking, Shiva PPP client, or Microsoft RAS client software.

In this chapter:

SecurID Connectivity .................................................85
Dialing with Multilink PPP .......................................86
Establishing a Connection.......................................88
Connecting to the World Wide Web ................. 103

O n line  D a ta b a se

B ranch O ffice LA N

ISDN
Internet

D IVA  T /A  IS D N  M odem

A na log  D evice  S up port
(Ava ilable on  som e m odels )

D IVA  T /A  IS D N  M odem
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SecurID Connectivity

If you are using V.120, SecurID is available on all platforms. If you are using PPP or multilink 
PPP, SecurID is only available with Windows 95/98/NT4. Note that SecurID using PAP-Token 
and CHAP is not supported. PAP-Token and CHAP are usually used with servers other than 
Shiva (e.g. Ascend).

Using Windows 95/98 to Connect to a V.120 Server

The following example demonstrates how to use Windows 95/98 to connect to a V.120 
Server:

1 From the Dial-Up Networking group, right-click the connection on which you want to 
implement Secure ID, and select ‘Properties’.

2 Under the ‘Connect using’ field, click ‘Configure’.

3 Click the ‘Options’ tab and enable ‘Bring up terminal window after dialing’. 

When you connect to the V.120 SecurID server, a terminal window will pop-up and prompt 
for your user name and password.

Using PPP and Multilink PPP

If you want to use PPP or Multilink PPP to access a SecurID server, ask your administrator if:

• the server is using Shiva PAP as the authentication protocol

• the server supports these protocols

If these conditions are not met, you cannot use SecurID. If the conditions are met install one 
of the following:

• The Shiva ‘Security Pack’ software (a special patch for Windows 95/98) 

• The Shiva ‘DialIn’ software (replacement software for Windows 95/98 and Windows NT 
Dial-Up Networking)

These patches are available from your system administrator or at Shiva's Web site at 
http://www.shiva.com/remote/clientsoft/index.html. They add SPAP functionality to 
Windows. You require this added functionality to make a SecurID connection.

If you have trouble logging into a SecurID server, contact your administrator or Internet 
Service Provider (ISP).
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Dialing with Multilink PPP

When you establish a Multilink PPP connection, each B-channel connects to a 
remote-directory number. In some ISDN implementations, each B-channel connects to a 
unique number. If this is the case, enter both numbers and separate them with the character 
‘~’ or ‘&’. For example, to make a Multilink PPP connection to the numbers 555 1134 and 
555 1135, enter them as follows: 5551134~5551135.

For each telephone number, the maximum number of dialed digits is 40. The symbols # and * 
count as digits; punctuation (spaces, hyphens, periods, parentheses) and alphabetic digits (P, 
T, W, @, R) are ignored.

Using the " Symbol as a Shortcut

If you are dialing more than one number you can use the " symbol (the straight double-quote 
symbol) as a shortcut. For example, if you want to dial 8323005 and 8323006, you could 
simply type:

ATD8323005&"6

All numbers not specified in the second string are assumed to be the same as the first 
number. The two sets of numbers are assumed to have the same length.

Respect the following rules:

• The " symbol cannot be used alone

• The first B-channel must be specified first, before "

• The " symbol must directly follow the ‘&’ or ‘~’ symbols

• An X.25 DTE address can be specified, but should never count as the first number. The 
following example does not work:

ATDX8323000&"2

However, the following example does work:

ATDX8323000&8323001&"2
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• The " symbol can be used with all other ATD commands, for example:

ATDX8323000&8323001&"2

ATD%123&8323001&"2

Note:  If your ISDN implementation requires two numbers and BACP/BOD is enabled (on 
both your DIVA T/A and the remote ISDN device), you have the option of entering only one 
number. BACP will try to discover the second number and connect to it. If you know the two 
numbers, however, it is recommended that you enter both.

Note for Windows 95/98: If you use ‘~’ or ‘&’ to separate the phone numbers, deselect the 
‘Use Country and area code’ parameter on the Properties tab of Dial-Up Networking. 
Manually enter the Country Code, Area Code, and PBX Prefix (if required) for both numbers. 

If both B-channels connect to the same number, it is not necessary to enter it twice.

Contact your Internet Service Provider (ISP) if you are not sure whether you need one or two 
remote numbers.
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Establishing a Connection

Go to the section that corresponds to your platform and follow the procedure.

Windows 95/98..................89
Windows NT 4.0.................91
Windows NT 3.51 ..............94
Windows 3.x........................96
DOS ........................................98
OS/2 .................................... 100

Note:  For a destination ISDN telephone number, the maximum number of dialed digits you 
can enter is 40. The symbols # and * count as digits; punctuation (spaces, hyphens, periods, 
parentheses) and alphabetic digits (P, T, W, @, R) are ignored.



DIVA T/A ISDN Modem User’s Guide  �  Page 89

Using the DIVA T/A

Windows 95/98

1 Double-click the ‘Dial-Up Networking’ icon.

2 Double-click ‘Make New Connection’. The ‘Make New Connection’ wizard opens:

Select the ‘Eicon DIV AT-A ISDN Modem’ from the ‘Select a modem field’, then click ‘Next’.

3 Enter the ISDN number and country code of the location you wish to call, click ‘Next’, 
then click ‘Finish’.

4 Double-click the newly created ‘My Connection’ icon.
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5 Enter your user name and password, and click ‘Connect’.

6 If you successfully establish the connection, you can communicate with the remote host. 
If you do not establish the connection, verify your server type and TCP/IP settings and 
alter them as required.



DIVA T/A ISDN Modem User’s Guide  �  Page 91

Using the DIVA T/A

Windows NT 4.0

1 In the ‘Dial-Up Networking’ folder, double-click the ‘Make Connection’ icon.

2 Click ‘New’.

3 The ‘Phonebook Entry Wizard’ window opens. Click ‘Next’.

4 Check each applicable statement, then click ‘Next’.
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5 Enter the phone number you want to call, then click ‘Next’.

6 Click ‘Finish’.

7 Click ‘Dial’.
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8 Enter your user name and password, then click ‘OK’.

9 If you successfully establish the connection, you can communicate with the remote host. 
If you do not establish the connection, verify your configuration and TCP/IP settings and 
alter them as required.
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Windows NT 3.51

The following example assumes you are using RAS.

1 In the ‘Remote Access Service’ group, double-click ‘Remote Access’.

2 Click ‘Add’.

3 Enter the name and number you want to call, then click ‘OK’.

4 Click ‘Dial’.
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5 Enter your user name and password, then click ‘OK’.

6 If you successfully establish the connection, you can communicate with the remote host. 
If you do not establish the connection, verify your configuration and TCP/IP settings, and 
alter them as required.
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Windows 3.x

Note:  If your workstation is configured as a Windows for Workgroups Remote Access Service 
(RAS) client, you must configure the V.120 rate adaption protocol on both the DIVA T/A 
workstation and on the remote device (RAS Server ISDN adapter).

The following example assumes you are using the Shiva PPP protocol stack.

If you are using the Shiva PPP protocol stack (or similar), you can use PPP or MLPPP.

1 Ensure that the ShivaRemote connection software is installed on your computer.

2 Double-click ‘ShivaRemote Connect’.

3 Enter your dial-in name, password, and the phone number you want to dial.

4 Select the ‘Tools’ menu, and choose ‘Port Setup’. Select the ‘DI VAT/A’ as the modem, 
then click ‘OK’.

5 Click ‘Options’.

6
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7 Ensure that ‘IPX’ and/or ‘IP’ are enabled, then click ‘OK’.

8 Click ‘Connect’.

9 If you successfully establish the connection, you can communicate with the remote host. 
If you do not establish the connection, verify your configuration and TCP/IP settings, and 
alter them as required.
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DOS

1 Ensure that the ShivaRemote connection software (or similar) is installed on your 
computer.

2 Enter the following command:

C:\SHIVA\CONNECT

3 From the ‘Tools’ menu, choose ‘Port Setup’ and select the COM port.

4 Select ‘Modems’. Enter ‘Eicon DIVA T/A ISDN Modem’ in the ‘Modem Name’ field and set 
the speed to 115200 bps (or 230400 if your COM port supports it), then select ‘OK’.

5 Click ‘Network’.

6 Enable ‘IP’ and/or ‘IPX’ (as required), then select ‘OK’.
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7 Enter your user name, password, and the phone number you want to dial, then click 
‘Connect.’

8 If you successfully establish the connection, you can communicate with the remote host. 
If you do not establish the connection, verify your configuration and TCP/IP settings, and 
alter them as required.
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OS/2

1 Double-click ‘Programs’, then double-click ‘Internet Modems’.

2 Double-click ‘Dial Other Internet Providers’.

3 Click ‘Add Entry’.
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4 Enter your login ID, password, and the phone number you want to dial.

5 Click ‘Connect Info’, then enter your domain name server, your host name, and your 
server name.

6 Click ‘Modem Info’. Select a modem from the drop-down list, then select the COM port 
assigned to the DIVA T/A ISDN Modem.
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7 Click ‘Dial’ to place your call.

8 If you successfully establish the connection, you can communicate with the remote host. 
If you do not establish the connection, verify your configuration and TCP/IP settings, and 
alter them as required.
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Connecting to the World Wide Web

To connect to the World Wide Web, follow the instructions in the section “Establishing a 
Connection” on page 88; when the procedure instructs you to enter a dial-up number, enter 
the number of your Internet Service Provider (ISP).   

Once you are successfully connected to your ISP, go to your desktop and double-click the 
icon representing the web browser you want to use. The web browser opens and you are 
ready to explore the World Wide Web.

Note:  If you need help using your web browser or exploring the Web, consult your web 
browser's on-line help.
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Analog device ports are only available on certain DIVA T/A models. These two ports let you 
connect analog devices such as ordinary telephones, answering machines, fax machines, or 
modems to your DIVA T/A. Calls to and from these analog devices are carried over your ISDN 
line. You also get additional calling features such as Call Forwarding, etc. 

For more information on these calling features, see “Calling Features” on page 105.

Whenever possible, you should use Multilink PPP (MLPPP) since it provides maximum 
throughput with the remote device. 

In the case of a Multilink PPP connection that uses two B-channels, an analog device can still 
be used if Dynamic Bandwidth Allocation (DBA) is enabled. For example, while a MLPPP data 
connection is in progress using two B-channels, a telephone connected to one of the analog 
device ports rings. As soon as the phone rings, the MLPPP connection automatically drops 
one of the B-channels, reducing the data connection from 128 kbps to 64 kbps, and the voice 
call can then be connected. The same holds true if you decide to pick up the phone for an 
outgoing call.

After hanging up the voice call, the data connection re-establishes the second B-channel and 
brings the data connection back up to 128 kbps.

To use this feature, Dynamic Bandwidth Allocation (DBA) must be enabled. 

• If you are using Windows 95/98/NT, launch the Windows Configuration Tool and verify 
this option in the ‘Data’ tab (see page 44). 

• If you are using a Macintosh (System 7 or later), launch the Macintosh Configuration Tool 
and verify this option in the ‘Advanced’ tab (see page 70). 

• If you are using any other platform, use the VT100 Configuration Tool and verify this 
option in the ‘Advanced’ menu (see page 73).

You can also use the PPP, V.110, or V.120 protocols. In these cases, one B-channel is always 
available for voice.

Note:  There is no limit to the number of digits you can use when making calls through 
analog devices; however, calls made through ISDN have a maximum of 40 dialed digits.
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Calling Features

The DIVA T/A’s phone ports support a variety of calling features.

Call Hold .............................................................................106
Call Waiting .......................................................................107
Calling Line Identity Presentation.............................110
Calling Line Identity on Call Waiting ........................111
Calling Line Identity Restriction (CLIR) ....................112
Call Forwarding................................................................113
Malicious Caller Identification ....................................115
Call Redirection between Analog Ports ..................116
Three-party Conference Call .......................................117
Terminal Portability ........................................................118

See “Quick Reference” on page 119 for a summary of features and their corresponding keys.

Not All Features Available in All Regions

Features described on the following pages will only work if supported by your ISDN Service 
Provider and if enabled on your ISDN line. If you attempt to use a calling feature that is not 
available to you, you will hear a service failure tone (four beeps) through your telephone 
handset. Contact your ISDN Service Provider for more information on the calling features 
available in your area and the provisioning of your ISDN connection.
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Call Hold

Call Hold lets you suspend a voice conversation with a person (place them on hold), and 
make a call to a second number. You can then toggle back and forth between the first and 
second caller. When you are finished talking to the second person, you can hang up that call, 
and continue the call with the first person.

Using Call Hold

To place a call on hold:

1 With a voice call active, press R.
2 The person you are speaking with is placed on hold, and you hear a dial tone. 
3 Dial the number of the second party.

To switch between held calls

1 Press R, then wait for a dial tone.
2 Press 2. 

To disconnect the current cal land continue the other:

1 Press R, then wait for a dial-tone.
2 Press 1.

Note:  If you hang up while a call is on hold, the connection remains active and full 
communication charges may apply. To indicate that a call is still on hold, the phone will ring 
for 30 seconds (90 seconds in Denmark and Sweden). 
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Call Waiting

Call Waiting alerts you to a second incoming call during an active call. This feature is available 
as a service through your ISDN line (referred to as “ISDN Call Waiting”) and also from the 
DIVA T/A modem itself (referred to as “DIV AT/A Call Waiting”). 

The DIVA T/A’s internal Call Waiting uses the second B-channel (if available) to receive a 
second incoming call and offer it to you. However, if both B-channels are in use, DIV AT/A Call 
Waiting cannot offer you a call, and the second caller will hear a busy signal. ISDN Call 
Waiting is handled by your provider and does not need an available B-channel.

Enabling ISDN Call Waiting

ISDN Call Waiting can only be enabled by your ISDN service provider. If you are unsure if your 
ISDN line has this feature, check with your provider.

Enabling and Disabling DIVA T/A Call Waiting

To enable DIVA T/A Call Waiting:

1 Lift the receiver, then wait for a dial tone.
2 Press *43#. 
3 Three rising tones are played to confirm Call Waiting has been enabled. 

To disable DIVA T/A Call Waiting:

1 Lift the receiver, then wait for a dial tone.
2 Press #43#. 
3 Three falling tones are played to confirm that Call Waiting has been disabled.

To determine if Call Waiting is enabled

1 Lift the receiver, then wait for a dial tone.
2 Press *#43#. 
3 If enabled, you will hear three rising tones; if disabled, you will hear three falling tones.

Using Call Waiting When Alerted to a Second Incoming Call

In order to use the following keypad commands, your ISDN line must also support Call Hold. 
These commands apply to both ISDN Call Waiting and the DIVA T/A’s internal Call Waiting.

To ignore the incoming call:

1 Do nothing.
2 The two beeps will repeat  te nseconds later.

To reject the incoming call:

1 Press R and wait for a dial tone.
2 Press 0.
3 The incoming caller will receive a busy signal. Call Waiting will also be disabled for the 

duration of the call.
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To disconnect from the current call and accept the incoming call:

1 Press R and wait for a dial-tone.
2 Press 1.

To place the first call on hold and answer the incoming call:

1 Press R and wait for a dial-tone.
2 Press 2.

Once the call is on hold, you can toggle back and forth between the two parties by pressing 
R,2. To disconnect from the current call and reconnect to the held call, pres sR,1.

Enabling DIVA T/A Call Waiting using the Configuration Tool

The DIVA T/A Call Waiting setting is also available through the DIVA Terminal Adapter 
Program, which you can run by double-clicking the T/A icon in the lower right corner of the 
Windows taskbar. Once launched, double-click the DIVA T/A icon, then click one of the Phone 
Port tabs. The ‘Call Waiting’ setting is available in the ‘Options’ area, as shown below. 

(If you are using a Macintosh, see the command AT*Wn in the Reference Guide.)

Notes on Call Waiting Behaviour

The following situations apply if you are on the phone and a second call comes in:

If... Then...

• ISDN Call Waiting is available 
through your ISDN line

• You will hear a Call Waiting alert. 
• Call switching is handled by your ISDN service provider.

• ISDN Call Waiting is not available
• The DIVA T/A’s Call Waiting is disabled

• The second call receives a busy signal.
• You do not receive a Call Waiting alert.

Click here to 
enable or disable 
DIVA T/A 
Call Waiting
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Note on Call Bumping

If ISDN Call Waiting is disabled, Call Bumping will not occur, as MultiLink PPP uses the Call 
Waiting signalling information from your service provider to determine if it should release a 
B-channel to accomodate an incoming voice call. For more information on Call Bumping, see 
“General Tab” on page 38.

• ISDN Call Waiting is not available
• The DIVA T/A’s Call Waiting is enabled
• But both B-channels are in use

• The second call receives a busy signal, as the DIVA T/A’s 
internal Call Waiting requires a free B-channel in order 
to hold the call.

• ISDN Call Waiting is not available
• The DIVA T/A’s Call Waiting is enabled
• One B-channel is free!

• You will hear a Call Waiting alert.
• The second call occupies the available B-channel.  
• Call switching is handled by the DIVA T/A.

If... Then...
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Calling Line Identity Presentation

Calling Line Identity Presentation works with telephones equipped with a Call Display 
indicator. When you receive an incoming call, the number of the call is displayed. 

This feature is supported in Ireland, United Kingdom, Sweden, Denmark, France, and the 
United Arab Emirates.
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Calling Line Identity on Call Waiting

Calling Line Identity on Call Waiting works with telephones equipped with a Call Display 
indicator. With this feature, if you are on the phone and another call comes in, the number of 
the second incoming call is displayed.

This feature is supported in Ireland, United Kingdom, China, Australia, Hong Kong, Singapore, 
and Denmark. 

Note:  In Denmark, this feature is known as CallerID Plus. CallerID Plus does not display the 
identity of the second call automatically; when you receive a Call Waiting signal, you must 
press R, then 9. The number of the incoming call will then be displayed, but you will remain 
connected to the person with whom you were talking. To connect to the incoming call, you 
must use the Call Waiting feature (see page 107) as normal.
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Calling Line Identity Restriction (CLIR)

This feature permits you to restrict Calling Line Identity on outgoing calls on a per-call basis. 
Currently this feature is supported on the DIV AT/A’s phone ports only, i.e., identification 
cannot be disabled on a data call or a voice-to-pc call. This feature is currently supported in 
Denmark, United Kingdom, and Ireland. 

To restrict identification on a per-call basis, you must enter a code before dialing the number. 
This code depends on your region.

Using CLIR

In Denmark:

1 Lift the receiver, then wait for a dial tone.
2 Dial *31# followed by the number you wish to call.

If you have CLIR enabled permanently on your line, you can temporarily using the prefix 
#31#.

In the United Kingdom and Ireland:

• Dial 141 before dialing the destination number. For example, if you were calling 
5551234, you would dial 1415551234. 

• If you have CLIR enabled permanently on your line, you can temporarily disable it with 
the prefix 1470 in the U.K. and 142 in Ireland.
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Call Forwarding

When enabled, Call Forwarding automatically transfers incoming calls to another number. 
This feature is supported in Sweden and may be supported in other countries; check with 
your ISDN service provider. 

The following instructions list the codes for Sweden. Check with your service provider for 
codes that will work in your area. 

To forward incoming calls when your line is busy:

1 Lift the receiver, then wait for a dial tone. 
2 Press *67*.
3 Enter the telephone number to which calls are to be forwarded.
4 Press #. 

To deactivate this feature, lift the receiver, wait for a dial tone, press #67#. 

To forward incoming calls if they are not answered within 28 seconds:

1 Lift the receiver, then wait for a dial tone.
2 Press *61*.
3 Enter the telephone number to which calls are to be forwarded.
4 Press #. 

To deactivate this feature, lift the receiver, wait for a dial tone, press #61#. 

To forward incoming calls to an announcement machine:

1 Lift the receiver, then wait for a dial tone.
2 Press *24*.
3 Enter the announcement code.
4 Press #. 

To deactivate this feature, lift the receiver, wait for a dial tone, press #24#.

To forward incoming calls to an operator:

1 Lift the receiver, then wait for a dial tone.
2 Press *230#.

To deactivate this feature, lift the receiver, wait for a dial tone, press #230#. 

To forward all incoming calls to a fixed number:

1 Lift the receiver, then wait for a dial tone.
2 Press *22#.

To deactivate this feature, lift the receiver, wait for a dial tone, press #22#. 
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To forward all incoming calls to a number you specify:

1 Lift the receiver, then wait for a dial tone.
2 Press *21*.
3 Enter the telephone number to which calls are to be forwarded.
4 Press #. 

To deactivate, lift your receiver, wait for a dial tone, press #21#. 

To detect if Call Forwarding is active:

If you are not sure whether or not this service is currently activate, lift the receiver and listen 
for the dial tone. If the tone is fast and intermittent, the service is active. If the tone is 
continuous, the service is not active.
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Malicious Caller Identification

Malicious Caller Identification allows you to register a calling number with your ISDN Service 
Provider. To invoke this feature while you are on a call, press R, wait for the dial-tone, then 
press *39#. The held call is then automatically reconnected.

This feature is supported in Sweden and may be supported in other regions (but is not 
supported in Australia). Check with your ISDN service provider. 

This feature requires that Call Hold be supported by your ISDN line. 

Using Malicious Caller Identification

To invoke Malicious Caller Identification:

1 While you are on a call, press R, then wait for a dial-tone.
2 Press *39#. 
3 The held call is then automatically reconnected.

You can also invoke this feature up to 30 seconds after the caller hangs up.
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Call Redirection between Analog Ports

If two analog devices are connected to your DIVA T/A, you can transfer a call from the device 
on one port to the device on the other. For example, you can transfer a call from the phone 
on the PHONE 1 port to the phone on the PHON E2 port. (This is also referred to as “internal 
transfer.”) To receive the transferred call, the second device must be on hook and not ringing.

This feature requires Call Hold to be supported by your ISDN service. 

Using Call Redirection between Analog Ports

To transfer a call to the other analog port:

1 Press R. The current call is put on hold (you will hear a dial tone).
2 Press ‘*’, then hang up. The second analog device rings. 
3 When the second analog device answers, the transfer is complete. 

To transfer the current call with a call on hold:

1 Press R. The current call is put on hold (you will hear the dial tone)
2 Press *. The last call connected is transferred.
3 When the second device answers, the transfer is complete.

Other options:

• To cancel the transfer, lift the receiver of the initiating device and press *R. The call is 
then re-established with the first device. 

• If the second device can not accept the redirected call (it is busy or ringing), the device 
initiating the transfer will ring. The call can then be answered and communication 
re-established.

• If the second device does not answer within 30 seconds (90 seconds in Denmark and 
Sweden), the call is cleared. Note that communication charges may apply while the 
transferred call is ringing (see Call Hold).
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Three-party Conference Call

This feature lets you speak with up to two people at the same time. Once a Three-party 
Conference Call is set up, you may drop a call and continue with the other caller, or you put 
the one caller on hold while staying connected to the other caller.

Using Three-party Conference Call

Setting up a Three-party Conference Call:

1 Dial the first number, then press R to place the call on hold.
2 Dial the second number.
3 Press R,3 to begin the conference call.

Drop a party while conference is active:

During the Three-party Conference Call, you can press R,1 to disconnect the last-connected 
party and continue talking to the remaining party.

Splitting and reconnecting the calling parties:

During the Three-party Conference Call, you can press R,2 to place the last connected party 
on hold and talk exclusively with the first-connected party. 

At this point you can press R,1 to disconnect the current call and switch to the call on hold; 
R,2 to switch between the two calls; or R,3 to re-establish the conference call (see “Call Hold” 
on page 106).

Note:  If you hang up during a three-way conference call, all connections are dropped 
immediately.
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Terminal Portability

Terminal Portability allows you to transfer an active analog call from your DIVA T/A to another 
ISDN terminal (an ISDN phone, for example) that shares the same access connection but is 
separate from the DIVA T/A.

To transfer the active call to a separate ISDN device:

1 Press R.
2 Press *79#. If you hear a dial tone, the call has been transferred successfully. You can 

hang up the phone.

Note:  If the transfer fails, you are reconnected to the active call.

To resume a call:

1 Lift the receiver of the phone that will resume the call.
2 Press *79#. The call is resumed.

Assigning “Call Identities”:

When transferring a call to the ISDN, you can give the call a “call identity”. To do this, press R, 
*79*num#, with num being a one, two, or three digit number. When resuming the call, you 
must again identify the call by pressing *79*num#. By default, calls do not receive an identity 
number (with the exception of Denmark, where calls are given the identity number of 1).
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Quick Reference

Always listen for a dial tone after pressing the R button.

Call Hold

R,1 Disconnect the current call and reconnect the held call

R,2 Toggle between calls

Call Waiting

R,0 Reject the incoming call and disable Call Waiting for the duration of the current call.

R,1 Disconnect from the current call and reconnect the held call

R,2 Hold the current call and accept the incoming call

*43# Activate DIVA T/A Call Waiting.

#43# Deactivate DIVA T/A Call Waiting.

*#43# Determine whether or not DIVA T/A Call Waiting is currently active.

Calling Line Identity Restriction (per-call basis only)

U.K., Ireland Prefix the number you wish to dial with the code 141. (To disable this feature in the 
U.K., use the prefix 1470; in Ireland, use 142.)

Denmark Enter *31# followed by the number you wish to dial (#31# to disable).

Call Forwarding (codes for Sweden shown)

*67*number# Forward incoming calls to number when line is busy (#67# to disable).

*61*number# Forward incoming calls to number if they are not answered within 28 seconds 
(#61# to disable).

*24*code# Forward incoming calls to announcement machine using code (#24# to disable).

*230# Forward calls to operator (#230# to disable).

*22# Forward incoming calls to fixed number (#22# to disable).

*21*number# Forward all incoming calls to number (#21# to disable).

Active? Dial tone is fast and intermittent.

Malicious Caller Identification (not available in Australia)

R,*39# Invoke Malicious Caller Identification for current call.

Call Redirection between Analog Ports

R,*,hang up Redirect current call to other analog port.

offhook,*,R Reclaim call if it has not yet been answered by other analog port.

Three-party Conference Call

R,3 Establish Conference Call with current connection and call on hold.

R,1 Drop last-connected party and continue with remaining party.

R,2 Place last connected call on hold and talk exclusively with the first-connected party 
(split the conference call). Press R,2 again to switch to the other party.

Terminal Portability

R,*79# Transfer current call to ISDN phone sharing same access as the DIVA T/A.

offhook,*79# Resume call transferred to ISDN phone.
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Many telephone companies can assign several directory numbers to your ISDN line. This 
service, called Multiple Subscriber Numbering, allows you to use one directory number for 
your telephone and one for you fax machine (for example), as well have a separate number 
for data calls that should be sent directly to your computer. But when an incoming call is 
received by the DIVA T/A, a decision must be made as to where the call should go. Should it 
be sent to the telephone you have connected on phone port 1? Should it go to your fax 
machine on phone port 2? Should it be sent to the computer via the serial port?

To support multiple numbers, the DIVA Terminal Adapters Program allows to configure the 
the DIVA T/A’s data and phone ports to answer directory numbers you specify. 

Your options include:

• Assigning a primary and secondary number to each phone port (see page 121).
• Configuring a port to answer any number not configured elsewhere (see page 123).
• Specifying what numbers the data port should answer (see page 124).
• Specifying an exclusive data port directory number (see page 125).
• Routing voice calls to your PC (Voice to PC) (see page 126).

These options are explained on the following pages. Note that this is a general review of the 
number assignment options. For complete details on using the Configuration Tool to change 
these settings, see “Configuring a Profile using the Configuration Tool” on page 37 
(Windows).

Note:  The descriptions below apply mainly to Windows-based computers, as the DIVA 
Terminal Adapters Program for the Macintosh currently does not allow you to assign more 
than two numbers. If you wish to assign more than two numbers, you must use the AT!N1, 
AT!N2, and AT!N5 commands (see the DIVA T/A Reference Guide for more information).

Accessing the Configuration Tool

To launch the DIVA Terminal Adapters Program and access the Configuration Tool, you can:

• double-click the T/A icon on the taskbar,

• or, click ‘Start’, ‘Programs’, ‘Eicon DIVA T-A ISDN Modem’, ‘Eicon DIVA Terminal Adapters’.

The ‘Eicon DIVA Terminal Adapters Program’ window appears as shown below. Double-click 
the DIVA T/A icon to launch the Configuration Tool.

Double-click
this icon to

access the
Configuration

Tool
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Assigning Primary and Secondary Numbers to the 
Phone Ports

To assign primary and secondary numbers to the phone ports, use the Configuration Tool’s 
Phone Port 1 or Phone Port 2 panels. The primary numbers from each Phone Port tab will be 
used in other panels (the ‘Call Routing’ setting in the ‘Advanced’ tab for example) and will 
also be answered by the Data port if a data call comes in. The secondary numbers are 
answered exclusively by the phone ports.

Secondary Phone Port Numbers and Distinctive Ring

If you enter a number in the ‘Second Number’ field at the bottom of either Phone Port 
panels, the DIVA T/A automatically enables distinctive ringing for that number, i.e., if a call is 
placed to the second number, the telephone ring will be different from the regular ring. This 
allows you to determine which number was dialed by the calling party. You can switch the 
distinctive ring from the secondary number to the first by enabling the ‘Switch Distinctive 
Ring’ option located in the Phone Port tabs.

Use of secondary numbers and TeleDanmark’s Duet service

TeleDanmark’s Duet service offers, as a package, a mobile phone number along with ISDN 
basic access and three directory numbers. With this service, if the mobile phone is switched 
off, calls placed to the mobile phone number are automatically forwarded to a specific 
directory number as assigned by TeleDanmark. 

To make use of this service with the DIVA T/A, you would enter this ‘mobile forwarding’ 
number in the secondary number field in order to receive the forwarded calls.

For example, suppose you are assigned three directory numbers: 555-1111 (which you will 
use for the telephone), 555-2222 (which you will use for fax), and 555-3333 (your mobile 
forwarding number). You connect your telephone to phone port 1 and your fax machine to 
phone port 2. To configure this on the DIVA T/A, you would:

Primary
Number

Secondary
Number



DIVA T/A ISDN Modem User’s Guide  �  Page 122

Multiple Subscriber Numbering

• Set the primary number of Phone Port 1 to 555-1111;
• Set the ‘Second Number’ field of Phone Port 1 to 555-3333;
• Set the primary number of Phone Port 2 to 555-2222.

In this scenario, calls placed to your mobile phone will be forwarded to 555-3333 if the 
mobile phone is not on.
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Configuring a Port to Answer Any Number 
not Configured Elsewhere

When a port is assigned a specific directory number, it only answers calls dialed to that 
number. For example, if you have been assigned the numbers 555-1234, 555-1235, and 
555-1236, and you configure Phone Port 1 to answer 555-1234, this phone port won’t try to 
answer calls placed to any of the two numbers assigned to you.

One feature of the DIVA T/A is that it allows you assign a port the status of having ‘no 
directory number’ (referred to as having been assigned a ‘blank’ DN). A port assigned a blank 
DN will answer any calls dialed to numbers not configured elsewhere.

For example, suppose you have four directory numbers assigned to your ISDN line: 555-1111, 
555-2222, 555-3333, and 555-4444. You enter 555-1111 as the primary number for phone 
port 1 and 555-2222 as its secondary number. The primary and secondary numbers for 
phone port 2 are left blank.

In this scenario, a call placed to 555-1111 will be sent to phone port 1. A call placed to 
555-2222 will also be sent to phone port 1 (as it is the secondary number for that port), and 
you will hear a distinctive ring. However, a call placed to either 555-3333 or 555-4444, both of 
which have not been configured to any other ports, will be sent to phone port 2.

Note that if Phone Port 2 is disabled (using the checkboxes on the ‘General’ panel), Phone 
Port 2 won’t answer the call.

You can disable 
phone ports 
entirely by 
unchecking 
these boxes
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Specifying what numbers the data port should answer

If you wish to set the data port parameters for the scenario described on the previous page, 
you would use the Configuration Tool’s ‘Data’ tab. Notice that the choices for the option 
‘Select a previously configured number’ are ‘555-1111’ (the primary number you specified in 
Phone Port 1 tab) and ‘No number’ (since you left the primary number field blank in the 
Phone Port 2 tab).

If you set this option to ‘555-1111’, the data port answers calls placed to 555-1111 only. If you 
set this option to ‘No number’, the data port answers on any call not placed to 555-1111 and 
555-2222 (remember that we configured 555-2222 to be Phone Port 1’s secondary number).

If you were to go back and set the primary number of Phone Port 2 to 555-3333, the data 
port answering options would be ‘555-1111’, ‘555-2222’, or ‘Both numbers’.
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Specifying an Exclusive Data Port Directory Number

A specific number can be assigned exclusively to the data ports via the ‘Data’ tab. Click on the 
option ‘Configure a unique number to use for data calls’, then enter the number. The data 
port will answer only on that directory number, ignoring all other assignments.

You can also use the AT command AT!N5 to set this parameter (see the DIVA T/A Reference 
Guide for more information).

If you enable 
this option, the 
data port will 
answer to this 
number only
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Routing voice calls to your computer (Voice to PC)

In addition to the two phone ports, calls can be sent to your computer through the serial 
port. Normally these are data calls, and the DIVA T/A can make the decision automatically; a 
data call should not be sent to the phone port, for example.

With the advent of Voice over PC software and hardware, it is possible to set up your 
computer to answer telephone calls. In this case, you may want to have voice calls sent to the 
computer instead of the phone port.

Suppose you wish to have a telephone application on your computer answer to voice calls 
placed to 555-1234. You would:

1 Enter 555-1234 as the primary number in either the ‘Phone Port 1’ or ‘Phone Port 2’ tab.

Primary
Number
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2 Click the ‘Advanced’ tab and enable the option ‘Enable voice calls to the PC’.

3 Go to the ‘Voice to PC’ tab and choose 555-1234 as the number to be answered.

Enable 
this option

Select 
555-1234
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4 Click on the ‘Advanced’ tab. In the ‘Call Routing’ group, under the column ‘Voice’, select 
‘PC’ for the directory number 555-111.

5 Click ‘OK’. The changes will be saved to the device.

You can also use the AT command AT!An to set these options (see the DIV AT/A Reference 
Guide for more information).

Note:  Once voice calls for a primary directory number have been configured to be sent to 
your computer, voice calls to the secondary number associated with the primary number will 
also be sent to the computer. For example, suppose you configure Phone Port 1 to answer on 
555-1234, then configure a secondary number of 555-1235. If you route voice calls placed to 
555-1234 to your computer, voice calls placed to 555-1235 will also be directed to your 
computer.

Select ‘PC’ to 
route voice 
calls to your PC
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In Australia, if you are installing a DIVA T/A with an S/T interface, you must correctly set up 
ISDN line termination to ensure the proper operation of your equipment.

To determine your termination requirements, see page 130.

About Setting ISDN Line Termination

To set ISDN line termination, you may have to install a terminating resistor or set a switch on 
the back of the DIVA T/A, depending on the model. To learn how to set ISDN line termination 
for your particular device, refer to the diagram below.

Installing the resistor

If termination is required and your DIVA T/A does not have a 100 ohm ISDN Line Termination 
Switch, install the 100 ohm terminating resistor that is included in your package as follows:

1 Insert the RJ-45 end of the ISDN cable into the resistor.

2 Insert the resistor into the ISDN port on the back of your DIV AT/A.

3 Insert the other end of your ISDN cable into your NT1.

Note:  The terminating resistor can also be plugged into the other end of the ISDN cable, 
then plugged into the NT1 (instead of into the back of the DIVA T/A). The resistor will work as 
long as it is between the DIVA T/A and the NT1; do not place the resistor between the NT1 
and the U interface.

100 ohm ISDN Line Termination Switch
(external terminating resistor not needed)

ISDN
Phone 1 Phone 2 Serial

Reset
On

Off

100
ISDN

Reset
Phone 1 Phone 2Serial

No ISDN Line Termination Switch
(external terminating resistor provided)

Terminating
Resistor

ISDN
Cable
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Determining Termination Requirements

Termination requirements vary depending on the number of devices connected to an 
external NT1 and the distance between these devices and the NT1. 

Single ISDN device

If the DIVA T/A is the only device connected to the external NT1, determine the length of the 
cable linking the two devices then follow the instructions below.

If the cable is longer than 75 meters (250 feet): 

• Connect the included terminating resistor; or,
set the DIV AT/A 100 ohm switch to the ON position.

• Set the NT1 to provide 100 ohms of resistance. Consult the manual provided with the 
NT1 for more detailed instructions. Note that some NT1s do not support connections 
over 75 meters (250 feet). Check your user documentation to determine the distance 
supported.

If the cable is shorter than 75 meters (250 feet): 

• Do not connect the included terminating resistor; or
set the DIV AT/A 100 ohm switch to the OFF position (this is the default).

• Set the NT1 to provide 50 ohms of resistance. Consult the manual provided with the NT1 
for more detailed instructions. 

Multiple ISDN devices

If the NT1 is connected to more that one ISDN device, determine the length of cable 
connecting the DIVA T/A to the NT1 then follow the instructions below.

If the cable is longer than 75 meters (250 feet): 

• Connect the included terminating resistor; or,
set the DIV AT/A 100 ohm switch to the ON position.

• Set the other ISDN devices to 100 ohms of resistance. Consult the manuals provided with 
these devices for more detailed instructions.

• Set the NT1 to no termination. Consult the manual provided with the NT1 for more 
detailed instructions. Note that some NT1s do not support connections over 75 meters 
(250 feet). Check your user documentation to determine the distance supported.

If the cable is shorter than 75 meters (250 feet): 

• Do not connect the included terminating resistor; or,
set the DIV AT/A 100 ohm switch to the OFF position (this is the default).

• Set the other ISDN devices to no termination. Consult the manuals provided with these 
devices for more detailed instructions.

• Set the NT1 to provide 50 ohms of resistance. Consult the manual provided with the NT1 
for more detailed instructions.
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This section provides information that will help you to troubleshoot DIV AT/A problems.

• For information on the DIVA T/A’s LED status indicators, see page 132.

• To read about common problems and their solutions, see page 134.

• To capture a memory dump of the DIVA T/A, see page 136.

When Isolating Problems

When isolating problems, consider the following questions:

• Were any changes recently made to the configuration or setup that might affect the 
DIVA T/A's performance?

• Does the problem occur while attempting to connect to a remote device for the first 
time?

• Is this a consistent problem that you can duplicate?
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LED Status Indicators on the DIVA T/A

The LED status indicators on the DIVA T/A display the state of the ISDN switch (D-channel) 
connection to the remote device (B-channel), and the connection to analog devices.

B1, B2 LEDs

D LED

Link LED

LED Description

Off No call activity on the specified B-channel. 

Flashing An outgoing or incoming connection is being established on the specified B-channel. 

Steady There is a successful connection on the specified B channel. 

LED Description

Off The ISDN physical interface is not activated. The LINK LED might provide additional 
status information.

Flashing Flashing indicates that the DIVA T/A has automatically disabled Always On / Dynamic 
ISDN due to a failure to dial and bring up the X.25 datalink on the D-channel. You can 
still use the DIVA T/A, but without the features of AO/DI.

Some ISDN service providers do not yet support AO/DI. If you know your ISDN line 
does not support this feature, disable this option. If you are using Windows, choose a 
protocol other than ‘MultiLink PPP with AO/DI’ (see “General Tab” on page 38). If you 
are using a Macintosh, disable the AO/DI option (see “Advanced Tab” on page 70).

If you are unsure if your ISDN line supports AO/DI, check with your service provider 
before enabling this option.

If AO/DI is supported and you have subscribed to it, verify that you have correctly 
configured your AO/DI settings (see page 48 if you are using Windows, or see 
page 68 for Macintosh).

Steady The ISDN physical interface is initialized and ready to place calls.

LED Description

Off The ISDN physical interface is not synchronized, or is improperly connected. 
Note: In Europe, this indicates an idle condition. 

Flashing The ISDN physical interface is synchronizing.

Steady The ISDN physical interface is activated. The D, B1, and B2 LEDs might provide 
additional status information. 

TX-RX
Phone Serial

DTE
ISDN

B1 B2 FAULT POWERD

D IVA T/A ISDN  M odem
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Phone LEDs

TX-RX LED

DTE LED

Fault LED

Power LED

LED Description

 Off No call activity on the specified voice channel. 

 Flashing An outgoing or incoming connection is being established on the specified voice 
channel. 

 Steady There is a connection on the specified voice channel. 

LED Description

Off There is no data being transferred on the serial port.

On (intermittent) Data is being transferred on the serial port.

LED Description

Off There is no call activity on the specified serial port.

Flashing An outgoing or incoming connection is being established on the serial port. 

Steady There is a connection on the serial port. 

LED Description

Off The unit is operating within normal parameters.

Flashing Indicates a hardware fault condition.

Steady Indicates a software fault condition.

LED Description

Off The unit is powered down.

Steady The unit is powered up.
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Common Problems

Listed below are possible solutions to common problems.

SecurID is not working with the DIVA T/A.

Depending on the server type, the DIVA T/A might support SecurID. For more information 
see “SecurID Connectivity” on page 85.

The Windows Configuration Tool does not detect the DIVA T/A.

If you are running RAS or the Dial-Up Networking Server, or if other software is using the 
DIVA T/A, shut them down and restart the Configuration Tool. Make sure that the COM port is 
free by trying to open it with software such as Hyperterminal. 

If you are using Windows 95/98, open Device Manager and verify if there are any conflicts. 
You might also want to try the diagnostic tool found in ‘Start’, ‘Settings’, ‘Control Panel’, 
‘Modems’.

After installation, the modem speed cannot be set higher than 115,200 bps (Windows 
95/98/NT 4.0)

Remove and re-install the INF file as described in “Windows 95/98/NT Installation and Setup” 
on page 9.

When I set my modem speed to 230,400 bps, Dial-up networking reports ‘Error 630: 
modem not responding…’

You are using a PC equipped with UART 16550, which only supports a maximum speed of 
115,200. Change the speed of your modem to 115,200 bps or install a fast COM port card.

Under Windows 95/98, you can determine your PC's maximum com port speed by selecting 
‘Start’, ‘Settings’, ‘Control Panel’, ‘Modems’, ‘Diagnostics’, ‘More Info’.

Dial-up Networking fails. The DTE LED does not flash during a dialing attempt.

Verify that Flow Control settings are correct for your modem. Under Windows 95/98 you can 
determine your modem settings by selecting ‘Start’, ‘Settings’, ‘Control Panel’, ‘Modems’, 
‘Properties’, ‘Connection Tab’, ‘Advanced’. On the ‘Advanced’ panel verify that ‘Use Flow 
Control’ is checked and ‘Hardware RTS/CTS’ is selected.

The ‘Fault’ LED goes on.

Contact Eicon Technology and follow the instructions in “Dumping the DIVA T/A Memory” on 
page 136.

When using V.120 you cannot connect to a Bit Surfer Pro modem.

Use the command AT!E4=10.

When using V.120 over a Bit Surfer Pro modem, you can connect but cannot transfer 
data.

Use a different packet size by entering the command AT!E0=256.
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When you pick up the phone you do not get a dial tone.

Make sure the ISDN line has voice capability. If you are using the S/T version, try removing 
other ISDN equipment on the line. Try using a different Directory Number on the phone port. 
If the problem persists, contact Eicon Technology.

The ‘Link’ LED does not go on.

Make certain that the cable in the ISDN connection has the right interface: ‘U’ or ‘S/T’. 

Characters are missing when displaying VT100 screens or AT command status.

Refresh the screen by escaping the VT100 screen or re-executing the AT command. If the 
problem persists, lower the COM port line speed.

Answering machine or fax has problems.

If an analog device is having automatic answering problems, try turning off the distinctive 
ring. Open the Configuration Tool and disable ‘Distinctive Ring’ in the ‘Phone Lines’ panel.

My Casio PhoneMate answering machine doesn't answer calls when plugged into the 
DIVA T/A.

The DIVA T/A provides a ring signal which differs from a real analog phone line but is 
compatible with most devices. The Casio is not compatible.



DIVA T/A ISDN Modem User’s Guide  �  Page 136

Troubleshooting the DIVA T/A

Dumping the DIVA T/A Memory

If a software fault condition occurs while you are using the DIVA T/A (‘Fault’ LED is on), you 
may need to capture a memory dump to a file. This file can be used by Eicon support to 
determine what caused this condition. 

Follow the steps below to obtain a DIV AT/A dump:

1 Exit your dialer program (for example, Dial-Up Networking for Win95/98) and start a 
terminal-emulation program such as HyperTerminal.

2 Type at then press Enter. The mini-monitor menu appears. 

Note:  If the DIVA T/A does not respond to AT commands, even if you exit and restart 
your terminal-emulation program, close all applications, shut down your computer, and 
turn it on again. Repeat steps 1 and 2. 

If the DIVA T/A still doesn't respond to commands, hold down the reset button (located 
on the back of the DIVA T/A) for at least five seconds; this forces the DIVA T/A to enter a 
sub-layer monitor mode. Start a terminal-emulation program and type at. The sub-layer 
mini-monitor menu should appear. Type at@quit, and proceed to step 3. 

3 Type at@dump (this command is case sensitive) and press Enter. The system responds 
with the following display:

Please start XMODEM reception of dump file

4 Use the XMODEM transfer protocol built into your terminal-emulation program to 
receive the dump file. After the transfer is complete, a message similar to the following is 
displayed:

Dump completed (539104 bytes sent)

If the transfer appears complete but no message is displayed, press Enter until the 
message is displayed.

5 Type AT and press Enter, then type at@quit (case sensitive) and press Enter again to 
restart your DIVAT/A.
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Suppose a user is charged a flat fee of $.08 each time a connection is established, plus $.01 
per minute of B-channel usage. 

Since the flat fee of $.08 is quite high relative to the per minute charge of $.01, the user 
should be careful not disconnect and reconnect too often. A good solution would be to set 
the initial billing interval to 480 (8 minutes), and the billing interval to 60 (1 minute). 

With these settings, the minimum time the second B-channel remains connected is 8 
minutes (as specified by the initial billing interval). If the second B-channel is needed longer 
than 8 minutes, the extra connection time will always occur in increments of 1 minute (as 
specified by the billing interval), e.g. for a total time of 9 minutes, 10 minutes, 11 minutes etc.

How the interval settings effect costs can best be seen with a usage scenario. Take a sample 
time period of 10 minutes in which the second B-channel is first needed for 2 minutes, is not 
needed for the next 5 minutes, and is then needed for another 2.5 minutes. Compare the 
costs when the initial billing interval is set to 240 and 480, as shown below.

Initial Billing Interval = 240 (4 minutes)

In this case the second B-channel would need to connect twice (since it is dropped after 4 
minutes). The total cost would be:

Initial Billing Interval = 480 (8 minutes)

The second B-channel would only need to connect once (since the first connection is not 
dropped). The total cost would be:

Note that there is no ‘one’ solution for setting the parameters, the key is to find a balance 
between the variables.

Connection cost $.08 x 2 connections = $.16

Call # 1      $.01 x 4 minutes = $.04

Call # 2      $.01 x 4 minute = $.04

Total = $.24

Connection cost $.08 x 1 connections = $.08

Call      $.01 x 10 minutes = $.10

Total = $.18
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Firmware Specifications

Feature Supported on DIVAT/A

WAN Protocols • PPP (Point-to-Point Protocol)
• Multilink PPP
• ISDN (Q.921/Q.931: EuroISDN, TPH1962/TS.013, and INS-Net64)
• V.110 Rate Adaption
• V.120 Rate Adaption

Voice Call Support • Call Bumping (DBA)
• µ-law or A-law Encoding
• Internal Ring Generation
• DTMF and Pulse Dialing
• Caller ID Delivery (country dependant)
• Calling Features: Call Hold, Call Waiting, Caller ID (country dependant), 

Call Forwarding (country dependant), Malicious Caller ID (country 
dependant), Call Redirection

Async-to-Sync 
Conversion

• Single- and multi-link PPP async-to-sync conversion

Bandwidth 
Optimization

• Multilink PPP
• Bandwidth Allocation Control Protocol (BACP)/Bandwidth on Demand (BOD)
• Data Compression (MPPC, STAC, Ascend compression)

Authentication • PAP/CHAP
• MS-CHAP compatible 
• SPAP (Shiva Password Authentication Protocol) compatible in PPP and 

Multilink PPP modes.
• SecurID

Management and 
Configuration

• Windows Configuration Tool
• Macintosh Configuration Tool
• VT-100 Terminal Emulation
• AT Commands
• Firmware upgrades using XModem Download or the Configuration Tool

Plug and Play • Windows Plug and Play External COM Device Compliant
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Hardware Specifications

Feature  Supported on DIVA T/A

ISDN Interface • 1 ISDN BRI U or ISDN BRI S/T (RJ45) 

Analog device 
Interface (selected 
models only)

• 2 Analog Ports (RJ11)
• Ringer Equivalence Number (REN) per POTS line: 3

Console Port • RS-232 Asynchronous
• 1200 bps to 230.4 kbps
• Automatic Baud Rate Detection

Non-Volatile 
Configuration

• 4 KB non-volatile memory for storing configuration profiles

Physical 
Dimensions

• Size: 1.5H x 6.0D x 8.5W inches (4.0H x 15.4D x 21.7W cm)
• Weight: 1.3 lbs (0.59 kg)

Environmental 
Requirements

• Operating Temperature: 32º F to 104º F (0º C to 40º C)
• Operating Humidity: 0 to 90% non-condensing

Power 
Requirements

• AC Voltage: 100-120 VAC or 220-240 VAC (wall transformer)
• Frequency: 50/60 Hz
• Power Consumption: 10 Watts maximum 

Approvals • CE 168 
• FCC Part 15 Class B and Part 68 
• Industry Canada CS03 issue 8
• CSA-C22.2N0 950-95
• BZT
• Austel
• China
• Malaysia
• Singapore
• India
• New Zealand
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Technical Support

Support via the World Wide Web

To obtain technical support, visit the Eicon Technology HelpWeb at:

• http://www.eicon.com/support/

Customer Service

For customer service, contact your local Eicon Technology supplier.

Other Eicon Technology Web Sites

You can find ISDN-related information and general information about Eicon Technology 
products and services from the following web site:

• http://www.eicon.com

http://www.eicon.com
http://www.eicon.com/support/
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Regulatory Information and Conditions 
of Use

Regulatory Information for Europe

This equipment displays the CE 168  mark to show that it has been tested and found to be 
in full compliance with the requirements of the Terminal Equipment, EMC and Low Voltage 
Directives (98/13/EC, 89/336/EEC and 72/23/EEC, as amended by Directive 93/68/EEC).

The CE 168  mark signifies that this product is approved for connection to ISDN within the 
EU and EEA.

Safety Status: TNV-1

No voltages within this equipment exceed SELV voltages. The ISDN port has TNV-1 Safety 
Status and all other interconnection points and ports are SELV.

This equipment draws power from an external power supply which has been separately 
approved. It does not draw power from the ISDN network.

Power Consumption

Check that power supply will not be overloaded. Maximum power consumption of the unit is 
stated in “Hardware Specifications” on page 139. The user must ensure that the total power 
drawn by the host computer, the DIVA T/A, and any other peripherals, does not exceed the 
capability of the host power supply unit.
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Limited Warranty

Eicon Technology Corporation warrants to the original purchaser of this Eicon Technology 
Product that it is to be in good working order for a period of five (5) years from the date of 
purchase from Eicon Technology or an authorized Eicon Technology dealer. Should this 
Product, in Eicon Technology's opinion, fail to be in good working order at any time during 
this five year warranty period, Eicon Technology will, at its option, repair or replace this 
Product at no additional charge except as set forth below. Repair parts and replacement 
Products will be furnished on an exchange basis and will be either reconditioned or new. All 
replaced parts and products become property of Eicon Technology. This Limited Warranty 
does not include service to repair damage to the Product resulting from accident, disaster, 
misuse, abuse, or non-authorized alterations, modifications, and/or repairs.

Products requiring Limited Warranty service during the warranty period should be delivered 
to Eicon Technology with proof of purchase. If the delivery is by mail, you agree to insure the 
Product or assume the risk of loss or damage in transit. You also agree to prepay shipping 
charges to Eicon Technology and to use the original shipping container or equivalent.

EICON TECHNOLOGY HEREBY DISCLAIMS ALL OTHER EXPRESSED AND IMPLIED WARRANTIES 
FOR THIS PRODUCT INCLUDING, BUT NOT LIMITED TO, THE WARRANTIES OF 
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. Some jurisdictions do not 
allow the exclusion of implied warranties, so the above limitations may not apply to you.

IN NO EVENT WILL EICON TECHNOLOGY BE LIABLE IN ANY WAY TO THE USER FOR DAMAGES, 
INCLUDING ANY LOST PROFITS, LOST SAVINGS, OR OTHER INCIDENTAL OR CONSEQUENTIAL 
DAMAGES ARISING OUT OF THE USE OF, OR INABILITY TO USE, SUCH PRODUCT. Some 
jurisdictions do not allow the exclusion or limitation of incidental or consequential damages 
for consumer products, so the above limitations or exclusions may not apply to you.

THIS WARRANTY GIVES YOU SPECIFIC LEGAL RIGHTS, AND YOU MAY ALSO HAVE OTHER 
RIGHTS WHICH MAY VARY FROM ONE JURISDICTION TO ANOTHER.

This Limited Warranty applies to hardware products only.
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Product Comment Form

DIVA T/A ISDN Modem
User's Guide - International
206-269-03
We value your comments. Please use the tables below to rate this product.

Please return the Product Comment form to: Eicon Technology Corporation
Attention: Corporate Publications
9800 Cavendish Blvd.
Montreal, Quebec, Canada, H4M 2V9
Email: techpub@eicon.com
Fax: (514) 745-5588
Tel: (514) 745-5500

Name

Title

Company

Address

DIVA T/A ISDN Modem
Packaging Poor ➀ ➁ ➂ ➃ ➄ ➅ ➆ ➇ ➈ ➉ Excellent

Configuration Difficult ➀ ➁ ➂ ➃ ➄ ➅ ➆ ➇ ➈ ➉ Easy

Performance Poor ➀ ➁ ➂ ➃ ➄ ➅ ➆ ➇ ➈ ➉ Excellent

Workmanship Poor ➀ ➁ ➂ ➃ ➄ ➅ ➆ ➇ ➈ ➉ Excellent

DIVA T/A ISDN Modem User's Guide
Accuracy Low ➀ ➁ ➂ ➃ ➄ ➅ ➆ ➇ ➈ ➉ High

Organization Confusing ➀ ➁ ➂ ➃ ➄ ➅ ➆ ➇ ➈ ➉ Clear

Readability Difficult ➀ ➁ ➂ ➃ ➄ ➅ ➆ ➇ ➈ ➉ Easy

Presentation Poor ➀ ➁ ➂ ➃ ➄ ➅ ➆ ➇ ➈ ➉ Excellent
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A
Advanced menu

VT100 Configuration Tool, 77
Advanced Tab

Macintosh, 70
Win95/98/NT, 51

Analog Device Support, 104
Answering numbers, 123
Assistant

Macintosh, 71

B
B1, B2 LEDs, 132
BACP

VT100 Configuration Tool, 77
BACP Tab

Macintosh, 65
Win95/98/NT, 46

Billing Interval
VT100 Configuration Tool, 78

Billing Interval Example, 137
Blank DNs, 123

C
Call Routing settings

Windows 95/98/NT, 51
Call Type setting

Windows 95/98/NT, 42
Calling Features, 105

Call Forwarding, 113
Call Hold, 106
Call Redirection Between Analog Ports, 116
Call Waiting, 107
Calling Line Identity on Call Waiting, 111
Calling Line Identity Presentation, 110
Calling Line Identity Restriction, 112
Malicious Caller Identification, 115
Three-party Conference Call, 117

Common problems and solutions, 134
Configuration

Windows 95/98/NT, 9
Configuration Assistant

Macintosh, 71
Configuration Profiles

About (Macintosh), 58
About (Win95/98/NT), 36

Configuration Wizard (Windows 95/98/NT), 54
Configuring a Profile

Macintosh (System 7 or later), 60
Manually (Win95/98/NT), 37
Using the Assistant (Macintosh), 71
Using the Wizard in Windows 95/98/NT, 54

Connecting the cables, 7

Cost Reduction Timers
Macintosh, 66
Windows 95/98/NT, 46

Country setting
Windows 95/98/NT, 38

Customer Service, 140

D
D LED, 132
Data port, numbers to answer, 124
Data protocol setting

Windows 95/98/NT, 38
Data Tab (Win95/98/NT), 44
Dialing out, 88
Dialing with MultiLink PPP, 86
Directory Numbers

VT100 Configuration Tool, 75
Distinctive Ring, 121
Distinctive Ring option

Macintosh, 64
VT100 Configuration Tool, 76
Windows 95/98/NT, 42

DIVA Terminal Adapters Program (Macintosh)
Advanced Tab, 70
BACP Tab, 65
Installation, 25
Introduction, 55
Location Tab, 63
Phone Lines Tab, 64
Protocol Tab, 62
X.25 Tab, 68

DIVA Terminal Adapters Program (Win95/98/NT)
Advanced Tab, 51
BACP Tab, 46
Data Tab, 44
General Tab, 38
Introduction, 32
Phone Port Tabs, 41
Voice to PC Tab, 53
X.25 Tab, 48

DOS setup, 31
Downloading firmware, 79
DTE LED, 133
Duet (TeleDanmark), 121
Dumping the DIVA T/A Memory, 136
Dynamic Bandwidth Allocation

Macintosh, 70
VT100 Configuration Tool, 77
Windows 95/98/NT, 45

E
Eicon HelpWeb, 140
Establishing a connection, 88
Exclusive data port number, 125
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F
Fault LED, 133
Fault LED is on, 134
Fax/Modem Only option

Macintosh, 64
VT100 Configuration Tool, 76
Windows 95/98/NT, 42

Firmware, updating, 79

G
General Tab (Win95/98/NT), 38

H
HelpWeb, 140

I
Installation

DIVA Terminal Adapters Program (Macintosh),
25

DOS, Windows 3.x, OS/2, Macintosh (prior to
System 7), and others, 31

Win3.x and Windows for Workgroups 3.11, 31
Windows 95/98/NT, 9

Installation and Setup
Macintosh (System 7 or later), 25

Introduction, 5
ISDN line termination, 129
ISDN Parameters menu

VT100 Configuration Tool, 75

L
LED Status Indicators, 132
Limited Warranty, 142
Line termination, ISDN, 129
Link LED, 132
Location Tab (Macintosh), 63

M
Macintosh

DIVA Terminal Adapters Program, 55
Installation and Setup (System 7 or later), 25
Setup, prior to System 7, 31

Malicious Caller Identification calling feature, 115
Memory, dumping the DIVA T/A’s, 136
MultiLink PPP

Configuring (Macintosh System 7 or later), 62
Configuring (Win95/98/NT), 38
Dialing, 86

MultiLink PPP protocol setting
Macintosh, 62
Windows 95/98/NT, 39

Multiple Subscriber Numbering, 120

N
Number Assignment

Windows 95/98/NT, 44
Number assignment, 120
Number/Feature Association

VT100 Configuration Tool, 77

O
OS/2 setup, 31

P
Phone LEDs, 133
Phone Line menu

VT100 Configuration Tool, 76
Phone Lines Tab (Macintosh), 64
Phone Port Tabs (Win95/98/NT), 41
Phone support, 104
Power LED, 133
PPP protocol setting

Macintosh, 62
Windows 95/98/NT, 38

Primary numbers, 121
Problems and solutions, 134
Profiles

About (Macintosh), 58
About (Win95/98/NT), 36
Configuring manually (Macintosh), 60
Configuring manually (Win95/98/NT), 37
Profiles window (Macintosh), 59
Profiles window (Win95/98/NT), 35

Protocol
Setting in Win95/98/NT, 38
Setting on Macintosh (System 7 or later), 62
Setting using VT100 Configuration Tool, 74

Protocol Tab (Macintosh), 62

R
Region

VT100 Configuration Tool, 76
Regulatory Information and Conditions of Use, 141
Requirements for installation, 6
Reset button, 136
Routing voice calls to your computer, 126

S
Secondary numbers, 121
SecurID Connectivity, 85
Setup

Cables, 7
DOS, Windows 3.x, OS/2, Macintosh (prior to

System 7), and others, 31
Windows 95/98/NT, 9

Solutions to common problems, 134
Specifications

Firmware, 138
Status Indicators, 132
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Support, 140
Switch Type setting

Macintosh, 63
VT100 Configuration Tool, 75

T
Technical Support, 140
Telephone Number settings

Macintosh, 63
Termination Resistor, 129
Three-party Conference Call calling feature, 117
Troubleshooting option (United Kingdom only), 52
Troubleshooting the DIVA T/A, 131
TX-RX LED, 133

U
Update Date/Time

VT100 Configuration Tool, 78
Update Time

Macintosh, 70
Updating firmware, 79
Use 2 Numbers option

Macintosh, 63
Using the DIVA T/A, 84

V
V.120 protocol setting

Macintosh, 62
Windows 95/98/NT, 40

Voice to PC option
Windows 95/98/NT, 52

Voice to PC Tab (Win95/98/NT), 53
Voice to PC, routing calls, 126
VT100 Configuration Tool, 73

W
Warranty, 142
Web Site, Eicon, 140
What you need, 6
Windows 3.x Installation, 31
Windows 95/98/NT

DIVA Terminal Adapters Program, 32
Installation and Setup, 9

Wizard (Windows 95/98/NT), 54
World Wide Web, connecting, 103

X
X.25 DTE Address

Macintosh, 63
X.25 Tab

Macintosh, 68
Win95/98/NT, 48
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